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1 Preface to SignDoc Desktop

Thank you for choosing SignDoc Desktop.

SignDoc Desktop allows you to embed handwritten signatures into
electronic documents (PDF and TIFF) in a legally binding, trustworthy, and
secure manner. SignDoc Desktop® allows you to visualize, fill and sign
electronic documents and create electronic signatures using your
handwritten signature. This documentation provides the description of the
SignDoc Desktop application usage.

Signing requires a signature capture device to be installed (writing tablets,
pen pads or interactive pen displays) or a Tablet PC with electromagnetic
digitizer or a smartphone. Tablets with Touchscreens using Windows 8
Professional are also supported. On Tablets with Windows 8 RT, such as the simple Surface
Tablet from Microsoft, the App SignDoc Mobile for Windows should be used instead of SignDoc
Desktop.

SignDoc Desktop captures the handwritten "biometric" signature plus time and date of the signing
ceremony. The integrity value (Hash) of the document will be calculated and stored in the signature
field together with the biometric signature. The captured signature will be displayed in the
document and is also visible in standard PDF Readers.

SignDoc Desktop® offers the following features:

· View electronic documents (PDF and TIFF)

· Auto-insert the signature fields
SignDoc Desktop can insert signature fields in PDF documents automatically at positions
indicated by text markers. The relative position of each signature field with respect to the text
marker and the size of the signature field can be configured.

· Fill in PDF forms
PDF documents containing editable form fields (text fields and check boxes) can be edited
directly in the SignDoc Desktop application.

· Scribble & Annotate
SignDoc Desktop allows users to draw freely on the electronic document in several colors.
The pen strokes from Tablet PCs, interactive pen displays or a regular mouse are converted
into digital ink.

· Sign documents electronically using your handwritten signatures
The digital signature contains biometric information about how the signature was signed
such as speed and pressure of pen strokes. These characteristics represent a biometric
profile which is unique to every individual and can not be reproduced by a forger.

· Organize document storage
The storage location can be configured, SignDoc Desktop will save the file when the icon
[Save and Close] is pressed.

· Display signed version
SignDoc Desktop displays the signature fields in a tree-view that also can be used to display
the version of the document when it was signed with any signature. Providing an easy way to
compare different versions of a document throughout a documents potentially complex
history of modifications.

· Perform validation
Validate signature signed by SignDoc Desktop from standard PDF viewers. Notably the
popular free Adobe Reader®.
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· Seamless Integration in e-Workflow
SignDoc Desktop delivers sample that shows the implementation and integration of the
ActiveX Control component. It can be used to integrate and customize the entire SignDoc
Desktop solution within your own application. Effortlessly open, sign, save and close the
document using the ActiveX interface.

· Convert into PDF format using SOFTPRO Printer Driver
SignDoc Desktop includes the SOFTPRO Printer Driver that enables a possibility to convert 
documents that are created in other applications into PDF format and open it directly in the
SignDoc Desktop application for the signing ceremony.

· Easily preview pages in large documents for quick navigation
SignDoc Desktop provides intuitive quick navigation of documents by providing a preview
sidebar for easily finding the pages you are looking for within your documents.

· Never wonder again if you have completed mandatory fields in your document forms
Mandatory fields that should never be left unsigned are easily searchable and displayed
within SignDoc Desktop for quick access.

· Usage of different certificate types for maximum flexibility and security
SignDoc Desktop provides the ability to use either self-signed certificates generated on the
fly, or you can use your own certificates for signing.

· Attach a variety of additional documents to your signed documents
Need a way to add additional documents to your contracts? SignDoc Desktop allows you the
flexibility of adding any attachment to a document before signing. The attachment is signed
and secured with the document to be signed.

· Attach a variety of additional documents directly from your scanner
Additional attachments can be added to a document directly from a scanner or camera.

· Sign your documents using a picture directly from your camera
Need additional proof of signing? Why not add a picture as a true signature within your
documents? SignDoc Desktop allows the placement of picture fields within a document and
let's you take a photo of your signer.

· Prevent documents from being tampered with in any way after signing
In addition to using Adobe standards for auditing, SignDoc Desktop also provides you with
an optional means of preventing ANY tampering with a document after it has been signed by
locking fields.

Please visit Kofax Website for more information about the trustworthy integration of handwritten
signatures in electronic processes.

2 Introduction to Digital Signatures

Digital Signatures

A digital signature in an electronic document functions like a handwritten signature for printed
documents. A valid digital signature can assert a person's (or entity’s) agreed consent to the
document which the signature was applied. Below are some of the common reasons for using
digital signatures.

Identity Authentication

One or more Digital Certificates accompany a digital signature. The digital certificate provides a
means of proving identity. They bind an identity to a pair of electronic keys that are used to encrypt
and sign the document.

Integrity

If a document is digitally signed any change to the document after the signature will be recognised.

http://www.kofax.de/products/kofax-signature-solutions
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It is considered computationally infeasible to modify a document and its signature to produce a new
document with a valid signature.

Non-repudiation of Origin

Secure digital signatures cannot be repudiated; the signer or a document cannot later disown it by
claiming the signature was forged.

Digital Time-stamping

SignDoc Desktop can be configured to use a digital time stamping service. The Digital time
stamping further enhances the digital signature security by providing secure time information about
creation and modification time of a document. A digital time stamping services issues a timestamp
which associates a date and time with a digital signature in a cryptographically strong way. This
system is particularly interesting when using the click to sign scenario.

Digital Signature Authentication

In SignDoc Desktop using the VerificationPolicy you can modify the behavior of SignDoc Digital
Certificate verification. Depending on your security requirements you can tailor the certificate
authentication to meet your needs.

VerificationPolicy.CertificateChain

The certificate chain, also known as the certification path, is a list of certificates used to
authenticate an entity. The process of verifying the authenticity and validity of a certificate involves
checking all of the certificates in the chain of certificates from the original, universally trusted
Certificate Authority, through any intermediate Certificate Authorities.

VerificationPolicy.CertificateRevocation

A Certificate revocation list is a list of certificates that have been revoked, and therefore should not
be relied upon.

VerificationPolicy.VerificationModel

Certificate verification model, only Windows Crypto API is supported at this time.

3 Installing and Uninstalling SignDoc Desktop

Installation Requirements

Installing SignDoc Desktop

Installing SignDoc Desktop Silently

Uninstalling SignDoc Desktop

3.1 Installation Requirements

SignDoc Desktop is developed and supported for usage on Microsoft® Windows 8 Professional,
Windows 7, and Windows Server 2008/2012.

 

 NOTE

Kofax offers the maintenance of the licensed Software only as long as each involved third-party
vendor of such software maintains the respective version of the system software (operating
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system, network, database, communications server) used by the customer. If the third party
vendor discontinues this maintenance, customer shall be obligated to convert to a version of
the system software supported by the vendor.

 

The following system requirements are given:

· CPU - Standard Desktop CPU

· RAM min. 1 GB

· min. 580 MB of free space

SignDoc Desktop is designed to work with various signature capturing devices. SignDoc Desktop
supports external USB signature capture devices, Tablet PC, Pen&Touch devices and
smartphones.

 

The SignDoc Desktop Setup already contains drivers of the
supported signature capture devices.

· Apple’s Bonjour Service is used to discover devices within the
local network.

 

3.2 Installing SignDoc Desktop

SignDoc Desktop can be installed using the automatic installer SignDocDesktop-3.4.7.exe. This
installer will install all the necessary components on your computer to assure that the application
can be started and used right away.

 

 IMPORTANT NOTE

SignDoc Desktop installation requires administrator rights. Please make sure that you are
logged in as a user with administrator rights, before starting the installer.

Please uninstall any previous version of the SignDoc Desktop before installing this new
version.

The installation process is logged in the file "%TEMP%\SignDoc_Setup.log".

 

To install SignDoc Desktop:

1. Start (double click) SignDoc Desktop installer SignDocDesktop-3.4.7.exe.
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2. The installer offers you to choose a preferred language to be used during installation process.
Choose the preferred language. English and German are currently supported. Click OK to
continue.
 

 

3. The installer will prepare the InstallShield Wizard. Once prepared, the welcome to the
InstallShield dialog will be displayed.

Please click Next to continue.
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4. License agreement will be displayed in the next dialog. Please read and accept it.
 

 

5. InstallShield Wizard will ask to specify the User Name and Company Name in the customer
information dialog. Specify the required information and click Next button to continue.
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6. Specify the destination location for the SignDoc Desktop. By default, InstallShield Wizard will
install SignDoc Desktop to:

C:\Program Files\Kofax\SignDocDesktop

Use the default destination folder or choose any other preferred destination folder using 
Browse.... Once selected, click Next to continue.
 

 

7. Select the features you would like to install. By default in the dialog the following options are
marked:
SignDoc Core, PDF Printer Driver 64-bit or 32-bit (inclusive GhostScript), Sample Unicode
Fonts, Tablet Driver, Touch&PenSupport and Sign2Phone
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Remove the check mark in the selection box in front of the components you do not want to
install. All selected features will be installed on the computer after clicking Next.
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8. The InstallShield will begin the installation process and the progress bar will be showing the
status of the installation. Please wait.
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9. In the optional feature Sign2Phone you can determine the usage of Sign2Phone.
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10. In the optional feature User-defined certificate for digital signature you can select your own
certificate file for the digital signatures as alternative to the self-signed certificate. A further
possibility is the usage of the Windows Certificate Store.
 

 

11. InstallShield will give the option to view the README file and/or to create a desktop icon for
SignDoc Desktop.

Please select the preferred options and click Finish to close the InstallShield Wizard.
 

 



Installing and Uninstalling SignDoc Desktop

Kofax SignDoc Desktop 3.4.7 - Installation and User Guide© 2016 Kofax Deutschland AG

Page 16 of 144

12. Under certain circumstances, which are dependent on the selection of the components to be
installed and the operating system, the following dialog is displayed:
 

 

13. The SignDoc Desktop installer has created an entry in your folder Programs. To start the
SignDoc Desktop application choose:

Start > Programs > Kofax > SignDoc Desktop > SignDoc Desktop
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If you have chosen the corresponding option in the finishing step of the InstallShield Wizard
you can also start SignDoc Desktop from the desktop icon:
 

3.3 Uninstalling SignDoc Desktop

 IMPORTANT NOTE

If you have installed a license this process will also delete your existing license.

It is recommended to backup your license file before starting the uninstallation process.

The default location of the license file is:

C:\ProgramData\SOFTPRO\Licenses\SignDoc.lic

 

SignDoc Desktop application can be uninstalled from:

Control Panel > Programs and Features

Please select SignDoc Desktop in the list of the installed applications and click Uninstall.

A message asking to confirm if you really would like to uninstall the selected application and its
features will be displayed.

 

 

Please confirm by clicking Yes and the uninstallation process will be started. The progress bar will
be indicating the status of the uninstallation.

Any of the following dialogues may appear during uninstallation.
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Please choose one of the options and confirm with OK.

 

 

If you click Yes the config directory in the installation path will not be deleted. The configuration
files SignDoc2.ini and SDAutoprepare.ini as well as the file 0001-public.key are preserved and
will not be overwritten with the next installation of SignDoc Desktop.

If you click No the directory the config directory and all the files contained in it will be deleted. Next
time SignDoc Desktop is installed the installation procedure will place the default files in this
directory directory.

Once completed, all the SignDoc Desktop application components will be removed.

3.4 Installing and Uninstalling SignDoc Desktop Silently

General

The installation can be run in silent mode e.g. using a batch file with some options.
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For this purpose a response file, by default setup.iss, will be needed.

A response file can be created by running the installation program (by default SignDocDesktop-

3.4.7.exe) with the /r option.

Create Response File for Installation Procedure

The install program SignDocDesktop-3.4.7.exe should be started in Record mode with the
following options.

Option Description

/r Record Mode

Displays all run-time Dialogs and stores the data in a file.

/f1 Path for response file

In the example: Setup.iss

 

Example

SignDocDesktop-3.4.7.exe /r /f1"C:\Temp\Setup.iss"

Create Response File for Uninstallation Procedure

The installation program SignDocDesktop-3.4.7.exe should be started in Record mode with the
following options.

 NOTE

SignDoc Desktop must be installed on the system (see Installing SignDoc Desktop).

 

Option Description

/r Record Mode

Displays all run-time Dialogs and stores the data in a file.

/f1 Path for response file

In the example: Uninstall_Setup.iss

 

Example

SignDocDesktop-3.4.7.exe /r /f1"C:\Temp\Uninstall_Setup.iss"

Installation in Silent Mode

1. Start the command window (CMD).

2. Start the installation procedure as shown in the example below.

Example

SignDocDesktop-3.4.7.exe /s /L1033 /f1"C:\Temp\Setup.iss" /f2"C:\Temp\Setup.log"
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Uninstallation in Silent Mode

1. Start the command window (CMD).

2. Start the uninstallation procedure as shown in the example below.

Example

SignDocDesktop-3.4.7.exe /s /L1033 /f1"C:\Temp\Uninstall_Setup.iss" /f2"C:\Temp\Setup.log"

Options

Option Description

/L1033 Installation in English

/L1031 Installation in German

/s Silent Mode

/f1 Path for the response file

/f2 Path for the log file, with the install result
(ResultCode=0 is called no errors)

 

4 Using SignDoc Desktop

Starting SignDoc Desktop

Signing a Document

Inserting a Picture into a Document

SignDoc Desktop Toolbar

SignDoc Desktop Menu

Signature Field Context Menu

Windows Explorer Integration

4.1 Starting SignDoc Desktop

Start your SignDoc Desktop application by opening the Start menu and selecting the SignDoc
Desktop start link:

Start > Programs > Kofax > SignDoc Desktop > SignDoc Desktop
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SignDoc Desktop welcomes you with a splash screen:

 

 

Your SignDoc Desktop application is started in the background and appears while the start screen
fades out.
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The screenshot below shows how SignDoc Desktop will appear with no document loaded:
 

 

Opening a document in SignDoc Desktop is a simple task and similar to many other applications
which you may be using:

· Just click the icon  Open in the sidebar

or select from the the menu bar the item

File > Open
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· The file selection dialog will be started.

· Select a PDF or TIFF document and click the Open button.

 

 

Starting SignDoc Desktop with Command Line Parameters

To start SignDoc Desktop with command line parameters please start SignDoc32.exe or
SignDoc32_cmd.exe from SignDoc Desktop installation folder. The default setting for the
installation folder is:

C:\Program Files\Kofax\SignDocDesktop

SignDoc32.exe is a Windows application. SignDoc32_cmd.exe is a console application; it starts
and exits synchronously. Both these application have the same command line parameters.

Open Document

To open a document in SignDoc Desktop use following syntax:

SignDoc32.exe [filename]

Please specify the fully qualified path to the desired file.

 

 NOTE

If there are spaces in the path please quote the entire path to the input file.
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Examples

SignDoc32.exe c:\sample.pdf
SignDoc32.exe "c:\my folder\sample.pdf"

Start Application Minimized

SignDoc32.exe -minimize

Start Application Maximized

SignDoc32.exe -maximize

Start Application with Specifying Prepare JavaScript File

The following example shows how you can open and prepare a document with a JavaScript file.

Example

SignDoc32.exe -jscript_prepare=detect.js c:\sample.pdf

Print a Document without a Graphical User Interface

To print a document using SignDoc Desktop without a Graphical User Interface use the following
syntax: 

SignDoc32.exe -print -pages [PAGES] -printer [PRINTER_NAME]
[filename]

Option Description

-pages Optional

Used in combination with -print, [PAGES] is a comma separated list of
integers

-printer Optional

Used in combination with -print, [PRINTER_NAME] is the printer name

 

Examples

SignDoc32.exe -print c:\sample.pdf
SignDoc32.exe -print -pages 1,2,3 c:\sample.pdf
SignDoc32.exe -print -printer "My Printer Name" c:\sample.pdf

 

To View a List of Command Line Options

To view a list of command line options printed to standard out please start: 

SignDoc32_cmd.exe -help
 

Examples

SignDoc32_cmd.exe -help
SignDoc32_cmd.exe -?
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See the chapter Signing a Document describing the first steps of usage of a SignDoc Desktop
application.

4.2 Signing a Document

 IMPORTANT NOTE

Please ensure a supported signature capture device is connected to the computer and is
properly installed.

 

1. Start the SignDoc Desktop application from the Start menu by selecting:

Start > Programs > Kofax > SignDoc Desktop > SignDoc Desktop

 

2. Open a PDF or TIFF from the menu bar with:

File > Open 

or use the sidebar icon  Open.
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3. The document will be displayed in the SignDoc Desktop application:
 

 

4. You can insert signature fields automatically or manually into a document. 

If the automatic signature field insertion has been pre-configured in the configuration file
SDAutoPrepare.ini

C:\Program Files\Kofax\SignDocDesktop\config\SDAutoPrepare.ini

the signature fields will be auto-inserted into the document while it is being opened. Please see
the chapter SDAutoprepare.ini for more information about how to configure the automatic
signature field insertion.

5. You may also insert the signature fields manually by clicking the toolbar icon  Insert
signature field and placing the signature field into the desired location within the document
with a second mouse click. The size and the position of the signature field can be changed also
using the mouse.
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6. By clicking the sidebar icon  Signatures it is possible to show or hide the list of the signed
and unsigned digital signature fields that are available in the document. Each signature field
also indicates the page number where the signature field is located. The picture below shows
an example of the document with  unsigned signature fields.
 

 



Using SignDoc Desktop

Kofax SignDoc Desktop 3.4.7 - Installation and User Guide© 2016 Kofax Deutschland AG

Page 28 of 144

7. With SignDoc Desktop you can edit the PDF documents with text fields and check boxes.
Click with the mouse on the field and enter the data into the field.
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8. Navigating in a PDF document can be easier if you highlight the editable fields using the

toolbar icon  Highlighting of form fields. All the editable fields will be displayed as on the
picture below.
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9. To start the signing process, please move the mouse over the signature field that you would
like to sign. In the context menu, that will appear, please click Sign. You can put focus on a
signature field by selecting it from the Digital Signature Fields list on the sidebar. Alternatively
you can double-click on the signature field, directly in the list.
 

 

10. The signature capture dialog will be shown.
 

 NOTE

When multiple supported signature capture devices are connected to the computer, all devices
will be used by default.

The signature capture dialog will display the input from the most recent active capture device.
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When the OK button is clicked on the signature capture dialog, the signature displayed in the
dialog with be captured.
 

 

11. In the signature capture dialog, please specify the signer name in the text field Signer Name.
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12. Sign on the signature capture device. Click the button OK to confirm the signature or click
Erase to re-enter the signature. Clicking Cancel the signing ceremony will be aborted and
signature capture dialog will be closed.
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13. After clicking OK the signature will be inserted into the document as shown on the picture
below.
 

 

14. Now the Digital Signature Field list will display the inserted signature under the Signatures
group.

 

15. When clicking on Signatures in the Digital Signature Fields list there will be additional
information displayed, such as Signer and Time. In addition a version of a document as it has
been signed will be saved below the corresponding signature field.
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 NOTE

Signer name and date is not visible in digital signature appearance for TIFF documents.
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16. A signed version of the current document can be viewed at any time, by double-clicking the

icon  View signed version below the corresponding signature in the Digital Signature
Fields list.
 

 

17. Once all signatures are captured it is possible to send the signed document to a pre-configured

folder, using toolbar icon  Save and Close. SignDoc Desktop can be configured to
validate the necessary (minimum) number of the signatures required before the document is
sent to the output folder. The configuration for the output folder can be done in the
configuration file SignDoc2.ini, which is available by default in the folder:

C:\Program Files\Kofax\SignDocDesktop\config\SignDoc2.ini

Please see chapter Save and close document for more information.

18. By the default, once the document has been sent to the output folder using the toolbar icon 

 Save and Close, the SignDoc Desktop application will be closed.
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4.3 Inserting a Picture into a Document

 NOTE

Please ensure a supported signature capture device is connected to the computer and is
properly installed.

 

1. Start the SignDoc Desktop application by selecting: 

Start > Programs > Kofax > SignDoc Desktop > SignDoc Desktop

 

 

2. To open a PDF or TIFF file, please select from the menu bar:

File > Open

or use the sidebar icon  Open.
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3. The document will be displayed in the SignDoc Desktop application:
 

 

4. If the automatic signature field insertion has been pre-configured in the configuration file
SDAutoPrepare.ini 

C:\Program Files\Kofax\SignDocDesktop\config\SDAutoPrepare.ini

the signature fields will be auto-inserted into the document while it is being opened. Please see
the chapter SDAutoprepare.ini for more information about how to configure the automatic
signature field insertion.

5. You may also insert the signature fields manually by clicking the toolbar icon  Insert
signature field and placing the signature field into the desired location within the document
with a second mouse click. The size and the position of the signature field can be changed also
using the mouse.
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6. By clicking the sidebar icon  Signatures it is possible to show or hide the list of the signed
and unsigned digital signature fields that are available in the document. Each signature field
also indicates the page number where the signature field is located.
 

 

7. To insert a picture, please move the mouse over the desired signature field. 

The menu will appear and you can select Picture. You can put focus on a signature field by
selecting it from the Digital Signature Fields list on the sidebar. 

If the Picture option is not visible in the context menu, please check your configuration file 
SignDoc.ini. In the [Signing] section of this file, the Capture setting should include 
sign_with_image: 

Capture=sign_with_signware,sign_with_image
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If signature field was inserted using SDAutoprepare.ini it is possible that there was an error
there.
 

 

8. The webcam capture dialog will be shown, you can optionally specify a name in the text field.
 

 

9. Click the button Preview to take a picture. When you are satisfied with the picture click the OK
button. Clicking the Cancel button aborts the webcam capture dialog.
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10. After clicking OK the picture will be inserted into the document as shown below.
 

4.4 SignDoc Desktop Toolbar

SignDoc Desktop Toolbar and Sidebar Icons

Open Document

Digital Signature Fields List

Preview Document Pages

Viewing Incomplete Mandatory Fields

Save Document

Print Document

Email Document as Attachment

Navigate Document

Zoom Document

Insert Signature Fields

Save and Close Document

Cancel Transaction

Scribble and Annotate

Eraser

Document Comments
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Highlight Fields

Adding Document Attachments

Creating Attachments

Prevent Changes to Document  after Signing

4.4.1 SignDoc Desktop Toolbar and Sidebar Icons

This chapter provides a description of all available SignDoc Desktop toolbar and sidebar icons.

 

 NOTE

SignDoc Desktop starts with a default setting for the display of the icons in the toolbar and
sidebar.

If you prefer not to display some of the icons within your solution, it can be configured in the
SignDoc2.ini configuration file. Please see the chapter SignDoc2.ini for more information.

 

Icons in the sidebar:

Icon Name and
Shortcut

Clicking this icon results in

Close current tab
Shortcut: Ctrl + W

Close the currently selected tab.

Next tab
Shortcut: Ctrl + Page Down

Switch to the next tab.

Previous tab
Shortcut: Ctrl + Page Up

Switch to the next tab.

Open
Shortcut: Ctrl + O

Opening the file selection dialogue box. Choose
the document which you want to open in SignDoc
Desktop.

Page preview Display a preview pane of all pages contained in
the currently active document

Signatures Display signature fields list on the left side of the
SignDoc Desktop window

Incomplete fields View mandatory fields that have not been
completed

Attachments Open the file attachment dialog
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Icons in the toolbar:

Icon Name and
Shortcut

Clicking this icon results in

Save
Shortcut: Ctrl + S

Saving the document

Print The document to be printed is sent directly to the
printer and printed. Before printing, no print menu
opens.

Email document as
attachment

Send the document as email attachment

First page Display the first page of the document

Previous page Display the previous page of the document

Next page Display the next page of the document

Last page Display the last page of the document

Select a page Jumping to any page of the document. Select the
requested page number from the drop down list.

Zoom out Decrease magnification of current page ("zoom
out")

Zoom in Increase magnification of current page ("zoom in")

Select zoom in % Selecting the preferred zoom in %

Insert signature field Inserting a signature field into the document

Save and close Sending the document to a pre-configured folder
and close

Cancel transaction Abortion of document processing

Pencil Use the pen to add handwritten notes, sketches,
annotations (scribbling)

Eraser Erase the handwritten notes

Comment Add or edit document comments

Highlighting of form fields Highlighting of the editable form field (check
boxes and text fields) available in the PDF
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Icon Name and
Shortcut

Clicking this icon results in

document

Capture image and save as
document attachment

Adding attachments via scanner or camera

 

4.4.2 Open Document

 Open

This sidebar icon allows you to quickly open a PDF or TIFF document in the SignDoc Desktop
application.

 

To open a file:

· click on the sidebar icon  Open

· in the Open dialog browse for the requested file

· click the button Open

 

By default in the Open dialog only PDF files are visible. If you would like to open a TIFF document,
please select the corresponding file format TIFF files in the drop-down list.

 

 HINT

Use the mouse to drag and drop a PDF or TIFF file into the SignDoc Desktop. Works when
dragging the icon on toolbar, sidebar, menu or document tabs.

Alternatively, to open a PDF or TIFF file directly in SignDoc Desktop you may right-click on the
preferred file in the Windows Explorer and select Sign with SignDoc from the context menu
(see Windows Explorer Integration).

4.4.3 Digital Signature Fields List

 Signatures

Click this sidebar icon to hide or show the digital signature fields list.
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The Digital Signature Fields list displays fields in two groups:

· Unsigned signature fields

· Signatures

 

 

Each signature field is listed with a complete name. Next to the field name a page number, where
the corresponding field is located is shown.

Clicking on the signature field in the digital signature field list will result in putting focus on the
signature field within the active document. To begin the signing of the signature field directly from
the digital signature field list, make a double-click on the preferred signature field. 

Once a signature field has been signed the Digital Signature Fields list will display the signed
field under the Signatures group.
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Click on the little triangle next to the signature field to view the additional information about the
selected signature:

· Signer name

· Date and time when signature was captured

· Button offering the ability to view the signed version of the document

 

 

View Signed Version

With each captured signature a signed version of the document is saved. This helps to save the
potentially complex history of the document changes.
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To view the signed version of the document for the particular signature simply click this icon 
 View signed version below the corresponding signature in the digital signature field list and the
version of the document as it has been signed will be displayed.
 

4.4.4 Preview Document Pages

 Page Preview

This sidebar icon allows you to quickly see a preview of all pages within the currently active/
displayed document and easily jump to specific pages.
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To activate the page preview sidebar:

· Click on the sidebar icon  Page Preview.
 

· Once activated, a page preview scrollable sidebar will be displayed showing all of the pages
contained within the currently active document. The pages are displayed as small
thumbnails, or “previews” of the actual page contents.

· To jump to a specific page scroll to the desired page within the sidebar.
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· Click on the desired thumbnail within the page preview sidebar to jump to that specific page.
 

 

 NOTE

Activating the page preview will de-activate any other currently open sidebar.
 

4.4.5 Viewing Incomplete Mandatory Fields

 Unsigned fields

This sidebar icon allows you to quickly get an overview of all pages within the currently active/
displayed document and easily jump to specific pages.

 

To activate the page preview sidebar:
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· Click the icon  Unsigned fields in the left sidebar. 
 

 

This will activate the Incomplete fields sidebar.
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The Incomplete fields sidebar lists all of the fields in the document that have not yet been
signed thereby providing a simple method of navigating to specific to-be-signed fields.
Clicking on any of the signature fields in the list will move the cursor in the main document
window to that specific field.
 

 

 NOTE

Activating the Incomplete fields sidebar will de-activate any other currently open sidebar.

4.4.6 Save Document

 Save

Using this toolbar icon the changes made to the active document can be saved.

 

This icon is disabled when there are no unsaved changes. The Save icon will become enabled only
when the document has been changed, for example text entered into the text fields or a check box
was checked or an annotations added using the Pencil tool.

To save the applied changes, select from the menu bar:

File > Save

or alternatively click the toolbar icon

 Save
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 NOTE

A document is always automatically saved when the document is signed.

 

It is also possible to save a document under a different file name or folder location. To do this:

· Select from the menu at the top of the application:

File > Save As... 

 

· You will then be prompted for file name and location for the newly saved file.
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· The currently open document will be renamed to the new file name you have chosen as
indicated on the document tab bar.
 

4.4.7 Print Document

 Print

By clicking on this tool, the document to be printed is sent directly to the printer and printed. Before
printing, no print menu opens.

4.4.8 Email Document as Attachment

 Email document as attachment

Using this toolbar icon the active document can be sent as email attachment.

4.4.9 Navigate Document

When opening a multiple page document in SignDoc Desktop, the document will be opened in the
single page view.

The toolbar icons shown below can be used for navigating through the document:
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Icon Name Description

First page Click this icon for quick navigation to the first page.

Previous
page

Click this icon to switch to the previous page. Alternatively use the
keyboard key PAGE UP.

Next page Click this icon to switch to the next page. Alternatively use the keyboard
key PAGE DOWN.

Last page Click on this icon for quick navigation to the last page.

Select page Lists all the pages that are available in the active document. Select the
page which you would like to view from the drop down list.

 

 HINT

Using the mouse wheel you can scroll the currently displayed page as well as go to the next or
previous page of the document.

4.4.10 Zoom Document

SignDoc Desktop toolbar offers several tools for changing the viewing magnification:

 

Icon Name Description

Zoom out Click this to decrease magnification of the current page

Zoom in Click this to increase magnification of the current page

Zoom Drop down list offers a possibility to select the preferred zoom %

4.4.11 Insert Signature Fields

 Insert signature field

This tool can be used to insert the signature fields into a document manually.

To place the signature field in a document:

· Navigate to the page where you would like to insert the signature field

· By clicking the toolbar icon  Insert signature field with the mouse, the tool will become
activated

· Move the mouse to the location in the document where you would like to place the signature



Using SignDoc Desktop

Kofax SignDoc Desktop 3.4.7 - Installation and User Guide© 2016 Kofax Deutschland AG

Page 54 of 144

field

· Click on the page to insert the signature field

 

By the default SignDoc Desktop inserts signature fields of medium size.

If you would like to insert the signature field in a different size, click on the little triangle next to the

icon  Insert signature field. The selection list as shown below will be displayed:
 

 

Switch to the necessary option prior placing the signature field. When placing the signature field
with the custom size click once to insert signature fields and keeping the mouse pressed drag to
the preferred size.

 

 HINT

The size of the signature field can be adjusted using the mouse; Using the mouse pointer you
can drag the corners of the signature field to the desired size.

The signature field can also be repositioned within the page by dragging.

Insert Signature Field button is disabled after the signing of the first signature field within a
TIFF document. All needed signature fields should be inserted first, and only after that they can
be signed.

 

To delete a signature field select Delete from the signature field context menu. See the chapter
Signature Field Context Menu for more information.

4.4.12 Save and Close Document

 

· Configuring Location

· Configuring Messages

· Configuring Rules

 Save and Close

This toolbar icon allows you to save the active document into a pre-configured location (directory or
a network share). By default, when clicking this toolbar icon SignDoc Desktop will save the
document into the root of the local harddisk (C:\) without applying any additional rules. Once the
active document is saved SignDoc Desktop will be closed. There will be no message displayed.

The location as well as some additional rules for document saving can be set in the SignDoc2.ini
configuration file. All the settings are grouped under the section [export_location] of the
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SignDoc2.ini configuration file. For detailed information about all the settings, please see chapter 
SignDoc2.ini.

Configuring Location

To change the default location for the document saving, perform following changes:

· Open SignDoc2.ini configuration file. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config\SignDoc2.ini

· Find the section [export_location.1]

· Change the value for the property export_location.output_dir

§ to save a document into a existing directory specify 

export_location.output_dir=C:/Directory

§ to save a document onto the network share specify 

export_location.output_dir//server/output

· save changes to SignDoc2.ini

Once the  Save and Close icon is clicked SignDoc Desktop will copy the active document
into the location configured in SignDoc2.ini configuration file, once that is finished, SignDoc
Desktop will be closed without displaying any message.

By default SignDoc Desktop is configured to use only one location for document saving. SignDoc
Desktop offers the possibility to configure several locations as backup in the situation the primary
location is unavailable. 

To enable usage of more then one location, please change the value for the property 
export_location.count and then configure proper locations below each section
[export_location.1] and [export_location.2].

 

 NOTE

When several locations have been configured, SignDoc Desktop will save the active document
only to the first successful location.

 WARNING

User should have access rights to export to target directory. Exporting to C:/ requires 
administrator rights.

If there is a file name collision (target file name and path already exists), the file is overwritten 
without warning.



Using SignDoc Desktop

Kofax SignDoc Desktop 3.4.7 - Installation and User Guide© 2016 Kofax Deutschland AG

Page 56 of 144

Configuring Messages

If the document saving failed, SignDoc Desktop will display the default error message shown
below:
 

 

The success and failure messages are also configurable. To configure the specific messages,
perform following changes:

· Open the SignDoc2.ini configuration file. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config\SignDoc2.ini

· Find the section [export_location.default]

· Change the value for the property export_location.message_success, for example:

export_location.message_success="My success message"

· Change the value for the property export_location.message_error, for example:

export_location.message_error="My message about not successful
document storage"

· Save changes to SignDoc2.ini

Configuring Rules
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Check Amount of Signatures

Before the document will be saved into the pre-configured location, it is possible to configure
SignDoc Desktop to validate the number of signatures in the active document. To configure,
perform following steps:

· Open the SignDoc2.ini configuration file. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config\SignDoc2.ini

· Find the section [export_location]

· Change the value for the property min_num_signatures, for example:

min_num_signatures=1

· Save changes to SignDoc2.ini

 

With a configuration like set in the example above SignDoc Desktop will check if at least one
signature is available in the active document before it is saved into the pre-configured location. If
the minimum number of the signatures are available, the document will be saved and SignDoc
Desktop will be closed. If the minimum number of the signatures is not available, the error
message below will be displayed:
 

 

Move the Document
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By default, when clicking the  Save and Close icon a copy of the active document will be
saved into the pre-configured location. If you would like to move the active document into the pre-
configured folder without keeping a copy of the file in the original directory from where it has been
opened, perform following configuration changes:

· Open the SignDoc2.ini configuration file. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config\SignDo2.ini

· Find the section [export_location]

· Change the value for the property input_file_delete, for example 

input_file_delete=true

· Save changes to SignDoc2.ini

4.4.13 Cancel Transaction

 Cancel Transaction

This toolbar icon allows you to quickly cancel the document processing without saving.

Once this toolbar icon is clicked the SignDoc Desktop application will be closed. All the unsaved
changes done to the active document will be lost.

4.4.14 Scribble and Annotate

 Pencil

This toolbar icon allows you to annotate comment or scribble basic drawings within an electronic
document.

The pen strokes from Tablet PCs or interactive pen displays or regular mouse are converted into
digital ink. 
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The Pencil tool is available in different colors. To select a color, click the little triangle next to the
icon and a drop down list as shown below will appear:
 

 

Select the preferred color and begin scribbling or annotating on the active document.

 

To erase the annotation use the Eraser tool.

 

 NOTE

This feature is not supported for TIFF documents.

4.4.15 Eraser

 Eraser

This toolbar icon will allow you to erase annotations and comments that were made in the
document using the Pencil tool.

4.4.16 Document Comments

 Comment

This toolbar icon allows you to annotate comments. The comments can be edited later on as well
moved and resized.
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Click on the icon in the toolbar and create the document comment with the mouse. Press the left
mouse button while drawing a rectangle.
 

 

 NOTE

This feature is not supported for TIFF documents.

4.4.17 Highlight Fields

 Highlighting of form fields

Using this toolbar icon you can highlight the editable form fields that are available in the PDF
document.

Supported form fields are:

· text fields

· check boxes

 

It is not required to highlight the fields to edit them. This icon will help you to quickly identify if a
PDF document has editable form fields or not.
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By default when opening a PDF document in SignDoc Desktop editable form fields are not
highlighted.
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Click on the toolbar icon  Highlighting of form fields and all the available form fields will
appear highlighted as shown on the picture below:
 

 

 NOTE

Highlighting fields is disabled for TIFF documents.

4.4.18 Adding Document Attachments

 

· About Attachments

· Attachment Operations

§ Adding Attachments Method 1: Attach File Button

§ Adding Attachments Method 2: Drag and Drop

§ Viewing attachments

§ Removing Attachments

§ Verifying Attachments

§ Renaming Attachments

§ Saving Attachments elsewhere
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 Attachments

This sidebar icon allows you to open the SignDoc Desktop Attachments sidebar.

Once activated the Attachments sidebar will be revealed on the left side of the SignDoc Desktop
application:
 

 

About Attachments

SignDoc Desktop allows the possibility to add any number of additional documents to the one that
is currently being signed.

These additional documents are attached to the original one and for the purposes of signing
become an integral part of the document that cannot be changed without a tampering being
detected. There is no limit to the number of documents that can be attached.

An attachment is bound to the version of the document with which it has been signed with the first
signature.

 

 NOTE

After signing a document you cannot add, rename or remove existing attachments.

 

Attachments are generally added to a document from the operating system's file system but they
can also be added directly from a scanner or camera (see Scanning Attachments for more
information).
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When attachments are present for the active document, an indicator will appear on the sidebar
icon indicating how many attachments are actually present:
 

 

 NOTE

Activating the Attachments sidebar will de-activate any other currently open sidebar.

Attachment Operations

There are several operations associated with attachments that can be performed in SignDoc
Desktop. These are:

· Adding attachments

· Viewing attachments

· Removing attachments

· Verifying attachments

· Renaming attachments

· Saving attachments elsewhere

 

Adding Attachments Method 1: Attach Files Button

Attachments can be added to the currently active document using the Attach Files button within
the Attachments sidebar.

To attach a file to the currently active document using the Attach Files button.

· Make sure the Attachments sidebar has been activated with the toolbar icon 



Kofax SignDoc Desktop 3.4.7 - Installation and User Guide © 2016 Kofax Deutschland AG

Using SignDoc DesktopPage 65 of 144

 Attachments

· Click the Attach Files button at the top of the Attachments sidebar:
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· A dialog will appear permitting you to select a file from the file system that you would like to
attach. This can be any file. Select it and click the Open button:
 



Kofax SignDoc Desktop 3.4.7 - Installation and User Guide © 2016 Kofax Deutschland AG

Using SignDoc DesktopPage 67 of 144

· The file will now appear in the list of attached files with an indication of its size and the time
and date of when it was attached:
 

 

Adding Attachments Method 2: Drag and Drop

Attachments can be added to the currently active document directly via drag and drop.

To do this:

· Make sure the Attachments sidebar has been activated with the toolbar icon 
 Attachments
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· Drag the desired file to be attached directly onto a free space within the sidebar
 

· The file will now appear in the list of attached files with an indication of its size and the time
and date of when it was attached:
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Viewing Attachments

Attachments to the active document can be opened and viewed individually. To do this:

· Select the attachment to be viewed from the Attachments sidebar

· Right-click on the attachment to activate the menu

· Select the Open menu item with the left mouse button
 

· When prompted to open the document, click Yes if you wish to do so
 

· The document will be opened with the default application for the attachment file type

Removing Attachments

Attachments to the active document can be removed from the document. To do this:

· Select the attachment to be viewed from the Attachments sidebar

· Right-click on the attachment to activate the menu
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· Select the Delete attachment menu item with the left mouse button
 

· The attachment will be removed from the document and will no longer be accessible

Verifying Attachments

Attachments to the active document can be verified to ensure that they are not corrupt and are
valid. To do this:

· Select the attachment to be viewed from the Attachments sidebar

· Right-click on the attachment to activate the menu
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· Select the Check attachment menu item with the left mouse button
 

· The attachment will be verified and you will be notified by a popup dialog of whether the file
is valid or not.

Renaming Attachments

Attachments may be renamed at any time. The name change will persist such that any time you
open the document, the new name will be used for the attachment. To do this:

· Select the attachment to be viewed from the Attachments sidebar

· Right-click on the attachment to activate the menu
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· Select the Rename menu item with the left mouse button
 

· A cursor will be placed at the position of the name. Start typing the new name for the
attachment and press the Enter key to complete the operation.

Saving Attachments Elsewhere

It may sometimes be desirable to save an attachment elsewhere for use outside of the document.
To do this:

· Select the attachment to be viewed from the Attachments sidebar

· Right-click on the attachment to activate the menu
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· Select in the menu the Save as option with the left mouse button
 

· You will be prompted to enter a file name and location for the attachment to be saved

4.4.19 Creating Attachments

 

· Adding document attachments via Scanner

· Adding document attachments via Camera

 

See also Document Attachments.

 

 Capture image

This toolbar icon starts the process for allowing additional documents to be added to the currently
active document directly from a camera or scanner.

 

 NOTE

To use this functionality you must have a scanner and/or camera attached to your computer
and have the required device software installed.

The capture button is not available when there is at least one signed signature field, in the
document. Adding attachments to a PDF document after it is signed corrupts the signature in
Adobe Reader.
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Adding Document Attachments via Scanner

To add an attachment to the currently active document using a scanner:

· The document is opened.

· Start the attachment scanner dialog by clicking the  Capture image toolbar icon.

· From the attachment scanner dialog select the scanner device from which you would like to
capture the attachment. If installed correctly, your scanner device should be available from
the Device drop-down list. Activate the drop-down menu and select your scanner.
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· Place the document to be used as an attachment in the scanner and click the Preview
button. This will initiate the scanning process.
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· Once the scanning has completed, a preview of the document to be attached will be visible
from within the scanning dialog. This allows you to ensure that the document has been
scanned as desired. If you are satisfied with the scanning results, click the OK button to add
the attachment to the currently active document.
 

· The attachment is now visible in the Attachments sidebar see Document Attachments

Adding Document Attachments via Camera

To add an attachment to the currently active document using a camera:

· Start the attachment scanner dialog by clicking the  Capture image toolbar icon.
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· From the attachment scanner dialog select the camera device from which you would like to
capture the attachment. If installed correctly, your camera should be available from the
Device drop-down list. Activate the drop-down menu and select your camera.
 

· When you are ready to take the picture from the camera, click the Preview button. This will
initiate the camera dialog which will allow you to take several photos. Once you have taken a
picture that you are satisfied with, select it by double clicking it.
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· The photo you have chosen will now appear as a preview within the scanning dialog. You
may now attach it to the currently active document by clicking the OK button.
 

· The attachment is now visible in the Attachments sidebar (see Document Attachments)

4.4.20 Prevent Changes to Document  after Signing

 

· Protecting Signature Fields

· Protecting both Signature and Editable Fields

 

Although the Adobe(R) standard for digital signatures allows the modification of documents after
signing as long as an audit trail is kept, it is sometimes desirable to prevent any type of
modification to the document after signing (see Digital Signature Fields List).

SignDoc Desktop provides the capability to "freeze" fields after signing so that it is no longer
possible to edit them. The effect of protecting fields can be set on a per Signature field basis. i.e.
Protection is changed by setting the properties of each individual signature field in the currently
active document. Before we describe how to do this, a few definitions are required:

Definition

Protecting Signature Fields: 
Protecting a signature field will have the effect that after the field is signed, the signature can no
longer be changed. It cannot be cleared/removed nor can it be re-signed.

Definition

Protecting Signature Fields and Editable Fields: 
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Protecting both a signature field and editable fields will have the effect that after the field is signed,
the signature can no longer be changed but additionally no other fields in the document can be
changed. After such a signature field that has this setting has been signed, the only possible
operation is the signing of other fields.

Protecting Signature Fields

To protect a signature field:

· Hover the mouse over the signature field that is to be protected

· Select from the menu Protect after sign... the Signature field option

 

 

· Now after that signature field is signed, it will no longer be possible to remove or re-sign it.

Protecting both Signature and Editable Fields

To protect all editable fields and a specific signature field:

· Hover the mouse over the signature field that is to be protected. A menu will appear.

· Select from the menu Protect after sign... the Signature field and editable fields option
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· Now after that field is signed, it will no longer be possible to remove or re-sign that field and
additionally it will not be possible to edit any of the fields in the document.

 

 NOTE

Signature field locking is not supported for TIFF documents.

4.5 SignDoc Desktop Menu

 

· Menu - File

· Menu - Help

 

In this chapter you will find the description of all the SignDoc Desktop menu items.

Menu - File

SignDoc Desktop menu File includes following sub-items:

 

 

Please find the description of all the sub-items of the File menu in the table below:

Menu Item Shortcut Description

Open... Ctrl+O Open a document

Save Ctrl+S Save changes to the active document

Save As... Save the document with another name

Close Ctrl+W Close the active document

Print... Ctrl+P Enables the display of the print menu of the used default
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Menu Item Shortcut Description

printer. By starting the print function you get a printout of the
displayed document.

Email document as
attachment

Send the document as an email attachment

Exit Exit the SignDoc Desktop application

 

Menu - Help

The SignDoc Desktop menu Help includes following sub-items:
 

 

Please find the description of all the sub-items of the Help menu in the table below:

Menu Item Description

Help Topics... Open the user manual

License Information... Check the validity of the SignDoc Desktop license

About SignDoc Desktop... Display the version information about SignDoc
Desktop and its modules

4.6 Signature Field Context Menu

Moving the mouse over the signature field that is available in the document will result into
displaying of the context menu.

Depending on the status of the signature field the context menu will offer different items.
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1. Signature field is empty (not signed):

· Select Sign if you would like to sign the selected signature field

· Select Delete if you prefer to remove the selected signature field

 

 NOTE

Signature fields inserted in the TIFF documents cannot be deleted.

Therefore the context menu for the unsigned signature field in the TIFF document does not
include the item Delete.

 

2. Signature field is signed:
 

3. Select Clear to remove the signature from the document.
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4.7 Windows Explorer Integration

It is possible to open documents with SignDoc Desktop right from the Windows Explorer. Right
click on a PDF or TIFF document and select Sign with SignDoc from the context menu:
 

5 SignDoc Desktop and Sign2Phone

Introduction to Sign2Phone

How to use Sign2Phone

Sign2Phone Administration

Sign2Phone Troubleshooting and FAQ

5.1 Introduction to Sign2Phone

Smartphone as Pad Alternative

· Sign2Phone is an App which can be installed on your smartphone.

· It allows you to use your smartphone as a signature capture device.

· The signing application running on your computer detects the smartphone as capture device.

· The connection from smartphone to the computer is protected via Transport Layer Security
(TLS) and unique pairing code.

· Sign2Phone App supports iPhone and Android and works with SignDoc Desktop.
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How it works - Overview

· The Sign2Phone app is available from the Apple App Store and Google Play Store store and
must be installed on the mobile device.

https://itunes.apple.com/app/id656164850
https://play.google.com/store/apps/details?id=de.softpro.sign2phone.googleplay.pro
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· The app is started on the mobile device by touching the Sign2Phone icon.

· The app is "paired" with the SignDoc Desktop application via the network.

· While the app is open, clicking on a signature field within the SignDoc Desktop application will
initiate a signature capture dialog in the app.
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· The signature is captured and transmitted in real-time to the desktop application which places it
in the document being signed.

Sign2Phone Connectivity

· In order for Sign2Phone to work, network connectivity is required between the desktop computer
where the signature is captured and the mobile device.

· This connectivity is achieved via WiFi i.e. both the desktop and the mobile device should reside
on the same network.

· Alternatively, a mobile network can be created  and connectivity can be achieved via USB Cable
whereby the mobile device must have the mobile personal hotspot functionality enabled.

5.2 How to use Sign2Phone

 

Kofax has implemented a service to locate available devices for
signature capturing.

Apple’s Bonjour Service is used to discover devices within the local
network.

More information about Bonjour Service:

http://www.apple.com/support/bonjour/

Wikipedia: Explanation of Bonjour® 

http://en.wikipedia.org/wiki/Bonjour_(software)

All discovered devices are displayed in a device selection list displayed by the desktop
application. The user selects a device for signature capture.

Make sure that mobile device and PC running desktop application reside on the same
network.

http://www.apple.com/support/bonjour/
http://en.wikipedia.org/wiki/Bonjour_(software)
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1. Startup on mobile device

Sign2Phone App is available as free download from the Apple App Store and Google Play Store.

The app is started by touching the Sign2Phone icon
 

 

on the device:
 

 

This will start the app used for capturing the signature.

https://itunes.apple.com/app/id656164850
https://play.google.com/store/apps/details?id=de.softpro.sign2phone.googleplay.pro
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2. Pairing procedure

Upon first start, a dialog offers the user the possibility to select the device that should be used to
capture the signature.
 

 

Select a device and click Next.

Now on the selected device (smartphone) the pairing code is displayed.

The desktop application will open a new dialog where you are prompted to enter this pairing
code.

Type this pairing code in the white box.
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By default the pairing code is stored and can be used for subsequent signatures. Remove the
check mark in front of Save pairing code persistently if you do not want to save this pairing
code.
 

 

Click Next to create a connection with the signature capturing device.
 

 

3. Signing procedure
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While the app is open, clicking on a signature field within the SignDoc Desktop application
initiates a signature capture dialog on both the mobile device and the desktop application.
 

SignDoc Desktop

Sign2Phone App

 

4. Signature Capture

The signature is captured and transmitted in real-time to the desktop application which places it
in the document being signed.

The signature is encrypted before transmitting the signature so that it can not be read or
tampered with.
 

SignDoc Desktop

Sign2Phone App

 

5. Signed document
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Once received the document places the signature in the document as an electronic signature.
 

 

If you want to capture another signature, a dialog displays a list of devices. Already connected
devices are marked.
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If you want to change the pairing code for the paired device, touch the icon  on the
smartphone.
 

Sign2Phone iOS

Sign2Phone Android

 

A new pairing code is created and can be entered in the desktop application.
 

 



Kofax SignDoc Desktop 3.4.7 - Installation and User Guide © 2016 Kofax Deutschland AG

SignDoc Desktop and Sign2PhonePage 93 of 144

 NOTE

The icon is displayed if the protocol is incompatible, i.e. either the application or the driver
SP_RemoteDrv.dll must be updated.
 

 

5.3 Sign2Phone Administration

Configuration

If SignDoc Desktop should use mobile devices as the only device for signature capturing you can
define this in the SignDoc Desktop configuration file. To do this set (see signdoc2.ini):

SigningCeremony.SignatureCapture.Device.Class=SPTabletRemoteTablet

Connectivity

A prerequisite to use Sign2Phone with SignDoc Desktop is, that the mobile device and the PC are
on the same network.

We recommend using an existing WiFi infrastructure to connect your mobile device with your
SignDoc Desktop installation. Make sure your PC and mobile device reside on the same network.

Nevertheless it is possible to set up local network environment between your mobile device and
your computer on which SignDoc Desktop is installed.

There are 3 possibilities to set up such local network environment (depending on your mobile
device and your mobile contract).

Establish connectivity between PC and mobile device - via Wi-Fi or USB Cable or Bluetooth:

· WiFi: Enable personal hotspot functionality on your mobile device and connect your
computer to this WiFi

· USB Cable: Enable personal hotspot functionality on your mobile device and use the USB
cable to connect to your computer

· Bluetooth: Enable personal hotspot functionality on your mobile device and connect it to your
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computer via Bluetooth

The mobile device communicates with the desktop application via TCP Port 46998 and UDP Port
5353 (service name is sp-remotetablet). A secure connection can be established by limiting the
mobile device connectivity to only that port. All other ports may be blocked for security. This will
enable a secure solution via WiFi between the mobile devices and the desktop application.

5.4 Sign2Phone Troubleshooting and FAQ

Troubleshooting

1. How to enable the current instance to perform a new paring?

You have two options:

· Option 1: Close App, start the App again

· Option 2: Refresh the pairing code

2. Which network protocol needs to be used when desktop application is running on
Virtual Machine?

· Virtual machines have to use "Bridged Networking", the "NAT" network type does not work

3. My Smartphone is not displayed in the device selection list, what can I do?

· Please make sure that your mobile device and the Windows PC running e.g SignDoc
Desktop are on the same network.

· Please start the app "Sign2Phone" on your mobile device again and check if your device is
displayed in the list.

o If not, please close SignDoc Desktop and start the desktop application again. 

o Now your mobile device should be listed.

FAQ

1. How can I connect my PC to my iOS device?

· You can connect your devices via Personal Hotspot to your iPhone, iPad, or iPad mini in
several ways. 
Find more information in section "Connect your device" on the website Apple Support.

2. How can I use Sign2Phone when I am not in my home country?

· Enabling the Tethering will not work unless the data roaming is enabled.

· This is relevant if you are using your Smartphone outside your home country.

· Data roaming may incur extra charges from your provider telephone.

6 Tools

SOFTPRO Printer Driver

Converting PDF into TIFF

http://support.apple.com/kb/HT4517
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6.1 SOFTPRO Printer Driver

During SignDoc Desktop installation the option to install the feature PDF Printer Driver 32-bit or
PDF Printer Driver 64-bit is offered. This feature enables the possibility to convert the documents
created in the other applications into a PDF or TIFF format. Once conversion process is finished
the document will be automatically opened in SignDoc Desktop application for signing procedure.

When this feature is installed on the computer, you will find the SOFTPRO PDF Printer in the list
of the available printers.
 

To convert a document into a PDF format, please follow the steps:

· Select the menu Print in the application where the document is created.

· In the list of the available printers on the computer, select SOFTPRO PDF Printer

· If it is necessary to configure the printing preferences, click the button Properties

· Click OK to begin the printing process

· The document will be converted and opened in the SignDocDesktop application

· If SignDoc Desktop application has been configured to autoinsert the signature fields into the
document there will be the fields already available for signing.

· Please see the chapter SDAutoPrepare.ini to learn about the configuration.

· Now the document can be signed. See the chapter Signing a document.

 

SOFTPRO PDF Printer Printing Preferences

SOFTPRO PDF Printer allows to configure the printing preferences. To access the preferences
dialog, please select SOFTPRO PDF Printer in the available printer list and click the button
Properties.
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Printing Preferences dialog contains following tab panels:

· Paper/Layout - use this panel to select the paper size and orientation as well as resolution
etc.

Default settings:

o Paper size - A4

o Resolution - 150 dpi
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· Destination - use this tab panel to specify the destination type, saving mode and destination
folder etc.

Default settings:

o Destination type - pdf

o Destination folder - Documents folder of the current user
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· File Format Settings - in this tab panel please select the file format settings, compression
etc.

Default settings:

o Output format - pdf

o Compression - B & W images compress: CCITT Group 4
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· Plug-ins - if exists, plugins for chain processing can be enabled here
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· Action - use this tab panel to specify the action that will be executed after conversion.

Default settings:

o Action to execute SignDoc Desktop application is enabled
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· About - Information about the product is displayed here
 

6.2 Converting PDF into TIFF

 

· Options supported by SPSD2TIFF

· Example

 

A command line tool SPSD2TIFF.exe can be used to convert PDF documents to TIFF images. If
the PDF document contains the signature fields all the unsigned signature fields will be copied to
the TIFF document as well. Signature fields must not overlap and must be contained completely
within their page. When converting various parameters can be set. This chapter provides
description of the usage of the SPSD2TIFF.exe including all the supported options.

Please start the command line (run > cmd) and execute the command tool SPSD2TIFF.exe. The
tool can be found in the SignDoc Desktop installation directory:

C:\Program Files (x86)\Common Files\SOFTPRO\Shared
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The usage information of the tool will be shown.
 

 

Options Supported by SPSD2TIFF

SPSD2TIFF is invoked this way:

SPSD2TIFF SWITCHES INPUT OUTPUT

INPUT is the pathname of the input file (PDF or TIFF), OUTPUT is the pathname of the desired
output file (TIFF). The pathnames will be used as specified; no default extension will be added. 

The following switches are available:

Switch Description

-bw Convert to black and white (1 bit per pixel)

-c C See -compression C

-compression C Set the compression method for the output file. If this switch is not
specified, the output file will be uncompressed (and can therefore become
quite large). Available values for C are:

· group4 CCITT Group 4 (Fax), implies switch -bw

· LZW Lempel, Ziv und Welch

· RLE run-length encoding (Packbits)

· ZIP Adobe Deflate

-d N See -dpi N

-dpi N Set the resolution of the output document to N DPI (dots per inch). This
switch must be used if the input file is a PDF document. If -dpi is not
specified, the resolution of the input file will be used.

-i See -invisible

-invisible Create invisible fields
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SPSD2TIFF.exe returns one of these codes:

· 0 conversion successful

· 1 command line error

· 2 fatal error

Example

The example below shows how to convert a PDF document to TIFF image with 200dpi and fax
group4 compression:

SPSD2TIFF.exe -compression group4 -dpi 200 C:\Sample_PDF.pdf C:
\Sample_TIFF.tiff

The following result will be displayed in the command line:

Document converted.
Number of pages: 2
Number of unsigned signature fields copied: 2
Number of signed signature fields omitted: 0

 

After conversion you may open a TIFF document in the SignDoc Desktop using following
command:

SignDoc32.exe C:\Sample_TIFF.tiff

or

SignDoc32_cmd.exe C:\Sample_TIFF.tiff

 

 NOTE

Signature fields in the TIFF images are not moveable after saved.

7 Configuring SignDoc Desktop

SignDoc Desktop Configuration Files

SDAutoPrepare.ini

SignDoc2.ini

Date and Time Formatting

Font Configuration

7.1 SignDoc Desktop Configuration Files

SignDoc Desktop reads the following configuration files:

· SignDoc2.ini

· SDAutoPrepare.ini

· Signature Capture background

· Font Configuration
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SignDoc Desktop installs these configuration files in the installation folder. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config

User specific files can also be loaded relative to the %APPDATA% environmental variable:

%APPDATA%/SOFTPRO/SignDoc/config

The user specific location is searched prior to the installation folder.

Typically on windows

· Microsoft Windows 7 and Windows 8 / 8.1:

C:\Users\<username>\AppData\Roaming\SOFTPRO\SignDoc\config

To check the exact location of the application and user configuration files select from the menu
bar:

Help > About SignDoc...

SignDoc2.ini

SignDoc2.ini configuration file allows configuring the following:

· Visibility of the elements of the graphic user interface (GUI), toolbar icons, sidebar icons and
menu items

· Set the language of the application

· Configure some additional parameters like configuration of the export locations for the
signed document

· More configurations

For the detail description, please see the chapter SignDoc2.ini.

SDAutoPrepare.ini

SDAutoPrepare.ini configuration file offers a possibility to pre-configure the automatic insertion of
the signature fields at specified text positions within the PDF document. Signature field size and
offset can be configured. When configured the signature fields can be auto-inserted in the PDF
document when the PDF document will be opened in SignDoc Desktop application.

Please see the chapter SDAutoprepare.ini for more information about how to configure the
automatic signature field insertion.

Signature Capture Background

The signature capture dialog and if available the capture device LCD can be personalized. The
configuration files can be found in the SignDoc Desktop installation folder. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config

The configuration file is selected based on the configured language (see SignDoc2.ini).

Background_SignDoc_<LANG>.xml

Example for English:

Background_SignDoc_en.xml

The specification for the XML is found in SPSWObjects.dtd in the same directory.

Font Configuration
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To enable this configuration please update the fontConfigFile configuration setting in the
SignDoc2.ini configuration file.

A font configuration file is an XML document specifying the pathnames of TrueType font files and
font substitution rules.

For the detail description, please see the chapter Font Configuration.

7.2 SDAutoPrepare.ini

Using SDAutoPrepare.ini it is possible to configure SignDoc Desktop to auto-insert signature
fields in the PDF document at the moment the PDF document is opened in SignDoc Desktop
application.

The AutoPrepare settings allow you to specify a search string and other parameters so that you
can specify where to insert the signature field. This procedure is started when a document is
opened and will only attempt to insert signature fields into a document when there are no pre-
existing signature fields available.

In this chapter you will find:

· the detail description of all SDAutoPrepare.ini configuration file parameters

· an example, showing how to configure the SDAutoPrepare.ini to auto-insert signature fields
in the document at the predefined text positions.

The newly inserted signature fields are given unique names automatically. The first automatically
inserted signature field will be named DigitalSignatureField_0, the second automatically inserted
field DigitalSignatureField_1, and so on.

 

 NOTE

Automatic signature fields insertion using SDAutoPrepare.ini is currently supported only for
PDF documents.

For inserting a signature field into a TIFF document, please use an appropriate toolbar icon
within the SignDoc Desktop application.

 

Parameter Supported Values
Default Value

Description

field_list String, semicolon
separated list of unique
field IDs

Default: none

A list of field IDs, each ID represents a search and field
insertion parameter. Please specify the field IDs.

Example

field_list ="field1;field2"

[field1] Section specified in the field_list. Configuration for the first
signature field. Enter the field ID in [ ] as you have defined
it in the field_list parameter.

text String

Default: none

Text that will be searched in the document, where the
expected signature field is to be inserted. Each search text
field should be unique and non overlapping.

type signature, check_box, The type of field to be inserted.
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Parameter Supported Values
Default Value

Description

text

Default: signature

capture sign_with_signware;
sign_with_image

Default: 
sign_with_signware,sig
n_with_image

(Optional) A list of capture devices that will be shown in
the signature field context menu. The format is comma
separated list. 

Default behaviour is to show all capture devices in the
context menu.

Example

"sign_with_signware,sign_with_image"

flags Comma separated list
of flags

Supported Values:
required

Default: none

Flags to set for the inserted signature field. Only the
'required' field is current supported.  

start_page Positive number

Default for PDF: 1

First page from which the search for the specified text
string should begin. PDF documents start at page 1.

end_page Zero or positive number The search pages up to and including the specified end
page. To search until the end of the document specify 0.

x_offset Number
Default: 0

Offset in document points for the signature field to be
horizontally shifted right.

y_offset Number
Default: 0

Offset in document points for the signature field to be
vertically shifted top.

height Positive number
Default: 0

Height of the signature field in document points.

width Positive number
Default: 0

Width of the signature field in document points.

fix true; false

Default: false

(Optional) Fix the signature field. User will not be able to
reposition, resize or delete the field.

friendlynam
e

Text

Default: field name

(Optional) Name of the field, which will be displayed in the 
Digital Signature Fields list.

tooltip Text

Default: field name

(Optional) Tooltip of the field, which will be displayed when
the mouse is over the field.

profile AGENT; CUSTOMER;
WEBCAM

Default: none

(Optional) Used only with signature fields. Sets the profile
for the signature. Use this to specify the icon to display on
the signature sidebar and the signature capture device.



Kofax SignDoc Desktop 3.4.7 - Installation and User Guide © 2016 Kofax Deutschland AG

Configuring SignDoc DesktopPage 107 of 144

Parameter Supported Values
Default Value

Description

AGENT: Agent icon  and sign_with_signware

CUSTOMER: Customer icon  and
sign_with_signware

WEBCAM: Webcam icon  and sign_with_image

lock_after_
sign

self; all_editfields

Default: none

(Optional) Fields to lock (make read only) after signing
signature field.

self: locks only the currently signed signature field 
all_editfields: locks all editable text, check box fields
and the currently signed signature field

field_name
_prefix

String

Default: none

(Optional) The field name will be prefixed with the
specified string.

 

Example of SDAutoPrepare.ini Configuration

In the example below you can see, a configuration that can be used in SDAutoPrepare.ini in order
to auto-insert the signature fields in the PDF document at the positions, where the text strings 
Dealer and Customer are found.

· Go to the SignDoc Desktop installation folder and open the SDAutoPrepare.ini configuration
file. The default location is:

C:\Program Files\Kofax\SignDocDesktop\config\SDAutoPrepare.ini

· Apply changes as shown below:

[auto_insert]
field_list="field1;field2"
[field1]
text=Dealer
type=signature
start_page=1
end_page=0
x_offset=0
y_offset=10
height=30
width=150
fix=false
friendlyname=Signature_Dealer
[field2]
text=Customer
start_page=1
end_page=0
x_offset=0
y_offset=10
height=30
width=150
fix=false
friendlyname=Signature_Customer
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· Save changes to SDAutoPrepare.ini.

· Start SignDoc Desktop again and load the PDF document that contains the text Dealer and
Customer.

· Signature fields should be auto-inserted on the positions where the texts Dealer and
Customer are found.

7.3 SignDoc2.ini

 

· [General]

· [UserInterface]

· [ImageCapture]

· [Signing]

· [Verification]

· [export_location]

 

In this chapter you will find the detail description of all in SignDoc2.ini available parameters.

 

 NOTE

Please use forward slashes "/" whenever a directory path is required.

 

[General]

[General] - General section of the SignDoc2.ini file

Parameter Supported Values
Default Value

Description

title Enter any name.

Default: SignDoc
Desktop

The title will be displayed in the title bar of the
SignDoc Desktop application.

language en; de

Default: en

Using this setting it is possible to configure the
application language. English, German, Korean,
Russian languages are supported.

fontConfigFile SPFontConfig.xml

Default: Complete PATH
to the location of the
SPFontConfig.xml file.

Font configuration file(s), comma separated list of
font configuration files, please use forward
slashes.

print.dpi Positive integer

Default: 300

The dpi (dots per square inch) for printing
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Parameter Supported Values
Default Value

Description

AboutDialog.web
site

URL string

Default: www.kofax.com

About SignDoc dialog link URL

Window.startsize maximize; minimize;
default; lastknown

Default: lastknown

SignDoc Desktop application window start size

Prepare.JavaScri
ptFile

Specify a JavaScript file
name. With none the
feature is disabled.

Default: none

Prepare a document using a JavaScript file. 

If this parameter is used, the specified JavaScript
file has to be located in the SignDoc Desktop
installation directory.

 

[UserInterface]

[UserInterface] - Section to configure visibility of the GUI elements (toolbar and side bar
icons as well as the menu items)

Parameter Supported Values
Default Value

Description

SignatureFields.fi
xed

true; false

Default: false

This setting specifies if the signature fields will be
fixed or not.

If the value set to "true" then the signature fields
will not be possible to move, resize or delete.

SignatureFields.
ContextMenu.visi
ble

true; false

Default: true

Using this setting it is possible to disable the
Signature Field Context menu. If the value is set to
"false" then the element is disabled.

SignatureFields.
ContextMenu.Del
ete.visible

true; false

Default: true

This setting specifies if the signature fields context
menu item Delete is visible or not.

SignatureFields.
ContextMenu.Lo
ckAfterSign.visibl
e

true; false

Default: true

This setting specifies if the signature fields context
menu item Protect after sign... is visible or not.

SignatureFields.
ContextMenu.Cle
ar.visible

true; false

Default: true

This setting specifies if the signature fields context
menu item Clear signature is visible or not.

SignatureFields.d
ecorations

true; false

Default: true

Using this setting it is possible to hide or show
signature field decorations (i.e checkmark,
question mark, cross). Not supported in TIFF
documents.

WindowSystemB
uttons.visible

true; false

Default: true

Using this setting it is possible to hide or make
visible the buttons (Minimize, Maximize and Close)
that are displayed in the right corner of the

http://www.kofax.com
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Parameter Supported Values
Default Value

Description

SignDoc Desktop application title bar.

If the value set to "true" then the element is visible.

TabBar.visible true; false

Default: true

Using this setting it is possible to specify if the Tab
bar is visible or not.

If the value set to "true" then the element is visible.

CloseDocument
Button.visible

true; false

Default: true

Using this setting it is possible to specify if the 
 Document close button should be visible or not.

If the value set to "true" then the element is visible.

OpenButton.visib
le

true; false

Default: true

Using this setting it is possible to hide or make

visible the sidebar icon  Open.

If the value set to "true" then the element is visible.

PagesButton.visi
ble

true; false

Default: true

Using this setting it is possible to hide or make

visible the sidebar icon  Pages preview.

If the value set to "true" then the element is visible.

SignaturesButton
.visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the sidebar icon  Digital signature
fields.

If the value set to true then the element is visible.

RequiredFieldsB
utton.visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the sidebar icon  Incomplete fields.

If the value set to "true" then the element is visible.

AttachmentsButt
on.visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the sidebar icon  Attachments.

If the value set to "true" then the element is visible.

SaveButton.visibl
e

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Save.

If the value set to true then the element is visible.

PrintButton.visibl
e

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Print.

If the value set to true then the element is visible.
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Parameter Supported Values
Default Value

Description

EmailButton.visib
le

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Email document as
attachment.

If the value set to true then the element is visible.

FirstPageButton.
visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  First page.

If the value set to true then the element is visible.

PrevPageButton.
visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Previous page.

If the value set to true then the element is visible.

NextPageButton.
visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Next page.

If the value set to true then the element is visible.

LastPageButton.
visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Last page.

If the value set to true then the element is visible.

PageSelectCom
boButton.visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Select a page.

If the value set to true then the element is visible.

ZoomInButton.vi
sible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Zoom in.

If the value set to true then the element is visible.

ZoomOutButton.
visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Zoom out.

If the value set to true then the element is visible.

ZoomSelectCom
boButton.visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Select zoom
in %.

If the value set to true then the element is visible.

InsertSignatureFi
eldButton.visible

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Insert signature
field.
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Parameter Supported Values
Default Value

Description

If the value set to true then the element is visible.

ExportButton.visi
ble

true; false

Default: false

Using this setting it is possible to hide or make

visible the toolbar icon  Save and Close.

If the value set to true then the element is visible.

CancelTransacti
onButton.visible

true; false

Default: false

Using this setting it is possible to hide or make

visible the toolbar icon  Cancel transaction.

If the value set to true then the element is visible

DrawButton.visibl
e

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Pencil.

If the value set to "true" then the element is visible.

EraseButton.visib
le

true; false

Default: true

Using this setting it is possible to hide or make
visible the toolbar icon  Eraser.

If the value set to "true" then the element is visible.

NoteButton.visibl
e

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Comment that allows
adding annotations to the document.

If the value set to "true" then the element is visible.

FieldsButton.visi
ble

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Highlighting of form
fields.

If the value set to "true" then the element is visible.

AttachImage.visi
ble

true; false

Default: true

Using this setting it is possible to hide or make

visible the toolbar icon  Capture image and
save as document attachment.

If the value set to "true" then the element is visible.

OpenMenu.visibl
e

true; false

Default: true

This setting defines if the menu item File >
Open... should be visible or not.

If the value set to "true" then the menu item is
visible.

SaveMenu.visibl
e

true; false

Default: true

This setting defines if the menu item File > Save
should be visible or not.

If the value set to "true" then the menu item is
visible.
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Parameter Supported Values
Default Value

Description

SaveAsMenu.visi
ble

true; false

Default: true

This setting defines if the menu item File > Save
As... should be visible or not.

If the value set to "true" then the menu item is
visible.

CloseMenu.visibl
e

true; false

Default: true

This setting defines if the menu item File > Close
should be visible or not.

If the value set to "true" then the menu item is
visible.

PrintMenu.visible true; false

Default: true

This setting defines if the menu item File > Print...
should be visible or not.

If the value set to "true" then the menu item is
visible.

EmailMenu.visibl
e

true; false

Default: true

This setting defines if the menu item File > Email
document as attachment should be visible or not.

If the value set to "true" then the menu item is
visible.

ExitMenu.visible true; false

Default: true

This setting defines if the menu item File > Exit
should be visible or not.

If the value set to "true" then the menu item is
visible.

HelpTopicsMenu
.visible

true; false

Default: true

Using this setting it is possible to hide or make
visible the menu item Help > Help Topics....

If the value set to "true" then the element is visible

LicenseInformati
onMenu.visible

true; false

Default: true

This setting defines if the menu item Help >
License Information... should be visible or not.

If the value set to "true" then the menu item is
visible.

AboutMenu.visibl
e

true; false

Default: true

This setting defines if the menu item Help > About
SignDoc Desktop should be visible or not.

If the value set to "true" then the menu item is
visible.

 

[Signing]

[Signing] – Section of the SignDoc2.ini file for configuring the attributes for signing process

Parameter Supported Values
Default Value

Description

Capture sign_with_signware, A list of capture devices that will be shown in the
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Parameter Supported Values
Default Value

Description

sign_with_image

Default:
sign_with_signware,sign
_with_image

signature field context menu. The format is
comma separated list, example
"sign_with_signware,sign_with_image"

Certificate.selectio
n

SelfSigned; PKCS12;
'CertificateStore

Default: SelfSigned

Certificate to digitally sign the document.

If 'PKCS12' is selected please specify the
certificate file in Certificate.PKCS12.file.

Certificate.PKCS1
2.file

fully qualified path to the
PKCS12 file

Sign the document with a PKCS12 certificate file,
please use forward slashes.

Used when Certificate.selection is set to
"PKCS12"

Certificate.Certific
ateStore.source

hardware,software

Default behavior:
hardware,software

Used when Certificate.selection is set to
"CertificateStore".

Select only software-based and/or hardware-
based certificates.

The format is comma separated list, example
"hardware,software".

Certificate.Certific
ateStore.FilterCert
ificatesByIssuerC
ertificateFile

path to the DER encoded
certificate file

Used when Certificate.selection is set to
"CertificateStore".

DER encoded certificate file, please use forward
slashes. Setting this parameter adds the specified
DER-encoded certificate to a list of acceptable
issuer certificates.

A PDF document may contain (in its certificate
seed value dictionaries) additional restrictions for
acceptable issuer certificates.

A signer certificate is acceptable for the rule
defined by this parameter if it chains up to any of
the certificates in the list of acceptable issuer
certificates.

Certificate.Certific
ateStore.FilterCert
ificatesBySubject
CertificateFile

path to the DER encoded
certificate file

Used when Certificate.selection is set to
"CertificateStore".

DER encoded certificate file, please use forward
slashes. Setting this parameter adds the specified
DER-encoded certificate to a list of acceptable
certificates.

A PDF document may contain (in its certificate
seed value dictionaries) additional restrictions for
acceptable certificates.

Certificate.Certific
ateStore.FilterCert
ificatesByPolicy

The value must be a
valid ASN.1 object
identifier.

Used when Certificate.selection is set to
"CertificateStore".

A required certificate policy. Setting this
parameter adds the specified OID to a list of
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Parameter Supported Values
Default Value

Description

required policy object identifiers. All specified
policies are required for a certificate to be
accepted.

A PDF document may contain (in its certificate
seed value dictionaries) additional restrictions for
acceptable certificates.

Certificate.Certific
ateStore.FilterCert
ificatesBySubject
DN

An acceptable subject
Distinguished Name
(DN). The DN must be
formatted according to
RFC 4514, using short
names for the attribute
types.

Used when Certificate.selection is set to
"CertificateStore".

Setting this parameter adds the specified DN to a
list of acceptable DNs. Multi-valued RDNs and
multiple RDNs specifying a value for the same
attribute are not allowed.

A PDF document may contain (in its certificate
seed value dictionaries) additional restrictions for
acceptable certificates.

SigningCeremony
Gui

dialog; document

Default: dialog

User interface to capture the signatures. SignPad
is currently the only supported device for the
setting "document".

SigningCeremony.
SignatureCapture.
Device.Class

SPTabletRemoteTablet,
SPTabletInterlink,
SPTabletMobinetix,
SPTabletStepOver,
SPTabletTopaz,
SPTabletWSignPad,
SPTabletWacom,
SPTabletWTablet,
SPTabletVerifone,
SPTabletGeneric

Default: none

The device class that is to be used to capture a
signature.

Set the value to "SPTabletRemoteTablet" to only
connect to Sign2phone devices.

"SPTabletInterlink" interface to the SOFTPRO
Interlink driver

"SPTabletMobinetix" interface to Mobinetix driver

"SPTabletStepOver" interface to StepOver BlueM
and BlueM-LCD tablets

"SPTabletTopaz" interface to Topaz 1X5, 4X3 and
4X5 SE LCD tablets

"SPTabletWSignPad" interface to Wacom
SignPad tablets

"SPTabletWacom" interface to Wacom Intuos,
Graphire, etc. tablets

"SPTabletWTablet" interface to SOFTPRO eInk
driver to access TabletPCs

"SPTabletVerifone" interface to SOFTPRO driver
to access Verifone Mx 800 series tablets

"SPTabletGeneric" interface to SOFTPRO
generic access modules

BiometricSignatur
e.minimum

Number>=0

Default: 1

Minimum number of signature vectors for a
signature to be accepted. 
Recommended values: 0 or 1

BiometricSignatur true; false Save the biometric signature data in the
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Parameter Supported Values
Default Value

Description

e.save Default: true document, can be used for future signature
verification.

eSignPublicKeyFil
e

Specify your public key
location;

Default key: /config/
esignkey-public.key

Public key to encrypt the biometric data

SignerNameEntry.
visible

true; false

Default: true

This setting defines if the text field Signer Name
that is displayed in the signature capture dialog
should be visible or not.

If the value set to "true" then the menu item is
visible.

SignerNameEntry.
remember

any number

Default: 5

This setting defines number of signer names that
will be remembered in the Signer Name field.
The remembered entries will be available in the
drop down list.

If the value set to 5 then 5 signer names will be
remembered and available in the drop down list.

SignatureImage.c
olor

Hex RGB value for the
signature color,

Default: 000000 (black)

The configured color is used in the signature
capture dialog, Tablet LCD (for color tablets), and
the color of the signature image in the digital
signature appearance.

This configuration is not supported in TIFF
documents.

SignatureImage.al
ignment

left; right; center

Default: center

Signature image alignment in the digital signature
appearance. Not supported in TIFF documents.

SignatureText.font a string of the font name

Default: document
specified

This setting defines font name used in the
signature text. Font specified must be included in
the fontconfigFiles as a FontFile. Not supported in
TIFF documents.

SignatureText.alig
nment

left; right; center

Default: center

Signature text alignment in the digital signature
appearance. Not supported in TIFF documents.

SignatureText.tim
e.visible

true; false

Default: false

Display the sign time or not in the digital signature
appearance. Not supported in TIFF documents.

SignatureText.tim
e.formatting

Default UTC in ISO 8601
extended format

Format string determines the format of the date
and time text of the digital signature appearance, 
DateTimeFormatting. Not supported in TIFF
documents.

SignatureText.sig
ner.visible

true; false

Default: true

Display the signer name or not in the digital
signature appearance. Not supported in TIFF
documents.
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Parameter Supported Values
Default Value

Description

Signature.TimeSt
ampAuthority.conf
ig

TimeStampClientCertific
atePath,
TimeStampClientKeyPat
h,
TimeStampServerPassw
ord,
TimeStampServerTruste
dCertificatesPath,
TimeStampServerURL,
TimeStampServerUser,
TimeStampHashAlgorith
m

String of "|" separated list of key value pairs of
configuration values.

See Timestamp Server Integration.

VirtualButtonOK.vi
sible

true; false

Default: true This setting defines if the button  that is
displayed in the signature capture dialog should
be visible or not.

If the value set to "true" then the button is visible.

VirtualButtonOK.al
ignment

left; right; center

Default: left

This setting specifies the alignment of the 

 button that is displayed in the signature
capture dialog.

See Configuration priority.

VirtualButtonOK.w
idth

Number

Default: 300 This setting defines the width of the 
button. Changes of this setting apply only for
buttons that are displayed in the signature capture
devices with LCDisplay.

See Configuration priority.

VirtualButtonOK.h
eight

Number

Default: 100 This setting defines the height of the 
button. Changes of this setting apply only for
buttons that are displayed in the signature capture
devices with LCDisplay.

See Configuration priority.

VirtualButtonEras
e.visible

true; false

Default: true This setting defines if the button  that is
displayed in the signature capture dialog should
be visible or not.

If the value set to "true" then the button is visible.

VirtualButtonEras
e.alignment

left; right; center

Default: center

This setting specifies the alignment of the button 

 that is displayed in the signature
capture dialog.
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Parameter Supported Values
Default Value

Description

See Configuration priority.

VirtualButtonEras
e.width

Number;

Default: 300 This setting defines the width of the 
button. Changes of this setting apply only for
buttons that are displayed in the signature capture
devices with LCDisplay.

See Configuration priority.

VirtualButtonEras
e.height

Number;

Default: 100 This setting defines the height of the 
button. Changes of this setting apply only for
buttons that are displayed in the signature capture
devices with LCDisplay.

See Configuration priority.

VirtualButtonCanc
el.visible

true; false

Default: true This setting defines if the button  that is
displayed in the signature capture dialog should
be visible or not.

If the value set to "true" then the button is visible.

VirtualButtonCanc
el.alignment

left; right; center

Default: right

This setting specifies the alignment of the button 

 that is displayed in the signature
capture dialog.

See Configuration priority.

VirtualButtonCanc
el.width

Number

Default: 300 This setting defines the width of the 
button. Changes of this setting apply only for
buttons that are displayed in the signature capture
devices with LCDisplay.

See Configuration priority.

VirtualButtonCanc
el.height

Number

Default: 100 This setting defines the height of the 
button. Changes of this setting apply only for
buttons that are displayed in the signature capture
devices with LCDisplay.

See Configuration priority.

SigningCeremony
Document.zoom

Number>=0

Default: 0.75

Zoom the page until the field occupies this
percentage of the width value 0 to not zoom the
document.

VerifySignatureSo
urce.visible

true; false

Default: false

If the value is enabled and signature verification is
configured the verification source combobox is
displayed.



Kofax SignDoc Desktop 3.4.7 - Installation and User Guide © 2016 Kofax Deutschland AG

Configuring SignDoc DesktopPage 119 of 144

 

Timestamp Server Integration

Description of the supported configuration values:

· TimeStampClientCertificatePath
The pathname of a file containing the certificate in PEM format for authenticating to an RFC
3161 time-stamp server over HTTPS.
If the value is non-empty, TimeStampClientKeyPath must also be set.
If the value is empty, the client won't authenticate itself. The default value is empty.
See also TimeStampServerURL, TimeStampClientKeyPath, and
TimeStampServerTrustedCertificatesPath.

· TimeStampClientKeyPath
The pathname of a file containing the private key in PEM format for authenticating to an RFC
3161 time-stamp server over HTTPS.
If the value is non-empty, TimeStampClientCertificatePath must also be set.
If the value is empty, the client won't authenticate itself. The default value is empty.
See also TimeStampServerURL, TimeStampClientKeyPath, and
TimeStampServerTrustedCertificatesPath.

· TimeStampServerPassword
The password for Basic/Digest HTTP authentication to the time-stamp server. If this
parameter is set, TimeStampServerUser must also be set.

· TimeStampServerTrustedCertificatesPath
The pathname of a file containing trusted root certificates in PEM format for authenticating
RFC 3161 time-stamp servers over HTTPS.
If the value is empty, time-stamp servers won't be authenticated. The default value is empty.
See also TimeStampServerURL, TimeStampClientCertificatePath, and
TimeStampClientKeyPath.

· TimeStampServerURL
The URL of an RFC 3161 time-stamp server.
The scheme of the URL must be either "http" or "https".
See also TimeStampClientCertificatePath, TimeStampClientKeyPath,
TimeStampServerPassword, TimeStampServerTrustedCertificatesPath, and
TimeStampServerUser.

· TimeStampServerUser
The user name for Basic/Digest HTTP authentication to the time-stamp server. If this
parameter is set, string parameter TimeStampServerPassword must also be set.

· TimeStampHashAlgorithm
Hash algorithm for RFC 3161 timestamps. The default value is tsha_default.

tsha_default: Currently SHA-1, may change in future
tsha_sha1: SHA-1
tsha_sha256: SHA-256

 

Example

Signature.TimeStampAuthority.config="TimeStampServerURL=https://
www.timestampservice.com|TimeStampServerUser=myuser|
TimeStampServerPassword=secret|TimeStampHashAlgorithm=tsha_sha256"

 

Virtual button configuration priority

If a BackgroundObjectsXml is available in the installation the virtual button configuration is read
from this file, VirtualButton width, height and alignment from the SignDoc2.ini is ignored.
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[Verification]

[Verification] – Section of the SignDoc2.ini file for configuring the attributes for signature
verification process

Parameter Supported Values
Default Value

Description

VerificationPolicy.
CertificateChain

ccvp_dont_verify

ccvp_accept_self_signed

ccvp_accept_self_signed_
with_bio

ccvp_accept_self_signed_
with_rsa_bio

ccvp_require_trusted_root

Default:
ccvp_accept_self_signed_
with_rsa_bio

ccvp_dont_verify
Don't verify the certificate chain. Always pretend
that the certificate chain is OK.

ccvp_accept_self_signed
Accept self-signed certificates. If the signing
certificate is not self-signed, it must chain up to a
trusted root certificate.

ccvp_accept_self_signed_with_bio
Accept self-signed certificates if biometric data is
present. If the signing certificate is not self-
signed or if there is no biometric data, the
certificate must chain up to a trusted root
certificate. 

ccvp_accept_self_signed_with_rsa_bio
Accept self-signed certificates if asymmetrically
encrypted biometric data is present. If the
signing certificate is not self-signed or if there is
no biometric data or if the biometric data is not
encrypted with RSA, the certificate must chain
up to a trusted root certificate.

ccvp_require_trusted_root
Require a trusted root certificate. The signing
certificate must chain up to a trusted root
certificate.

VerificationPolicy.
CertificateRevoca
tion

crvp_dont_check

crvp_offline

crvp_online

Default: crvp_dont_check

crvp_dont_check
Don't verify revocation of certificates. Always
pretend that certificates have not been revoked.

crvp_offline
Check revocation, assume that certificates are
not revoked if the revocation server is offline.

crvp_online
Check revocation, assume that certificates are
revoked if the revocation server is offline.

VerificationPolicy.
VerificationModel

vm_windows vm_windows
Windows certificate verification model

 

[export_location]

[export_location] - Section for configuring exporting of the file

An export location is a directory where the file will be copied to when the user clicks the toolbar
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icon  Save and Close. The file will be exported only to the first successful location.

export_location allow users to configure the location the active document is exported when the

 Save and Close toolbar icon is clicked. SignDoc Desktop supports exporting to folders or
SFTP servers. Multiple export locations can be configured (see export_location.count), SignDoc
Desktop will attempt to export the document to each of these locations until it is successful. For
convenience there is a export_location.default to specify default values for each of the export
locations.

 

Parameter Supported Values
Default Value

Description

export_location.c
ount

Number

Default: none

Using this setting, please define the number of
the export locations

min_num_signat
ures

Number

Default: 0

With this setting it is possible to define a
minimum number of signatures that are required
before the document can be exported to the
defined location

input_file save; delete

Default: delete

This setting defines if the original document
should be saved/deleted after it has been
exported into the predefined export location. If
the value is set to "delete" the file will be deleted.

 

[export_location.default] - Section that lists the default values for the export locations

Parameter Supported Values
Default Value

Description

export_location.ty
pe

folder; sftp

Default: folder

Supported type are 'folder' and 'sftp'. 'folder' also
supports network shares. Note: OpenSSH SFTP
server are supported.

export_location.o
utput_dir

Directory

Default: none

Directory to export the file, please use forward
slashes. The file can only be exported to existing
directories.

export_location.type=folder

Fully qualified path to the export directory. If
empty the file will be exported into the SignDoc
Desktop installation directory.

export_location.type=sftp

If empty the root of the SFTP server is used. Use
"." for the user home directory.

export_location.p
refix

String prefix

Default: none

This setting specifies the prefix to add to file
name of the exported file.

export_location.p String postfix This setting specifies the postfix to add to file
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Parameter Supported Values
Default Value

Description

ostfix Default: none name of the exported file.

export_location.m
essage_success

Message

Default: none

This setting defines a message text that is
displayed if export was successful. The message
is language independent. If nothing is specified
then no message is displayed. Specify a
message text in “”

export_location.m
essage_error

Message

Default: Export failed.
Please check your
configuration.

This setting defines a message text that is
displayed if export failed. The message is
language independent. If nothing is specified
then no message is displayed. Specify a
message text in “”

export_location.h
ost

Host Used only with SFTP server

Name or IP address

export_location.p
ort

Port number

Default: 22

Used only with SFTP server

Port to connect to server

export_location.fi
ngerprint

SSH server fingerprint

Optional

Used only with SFTP server

Fingerprint of the SSH server

export_location.lo
gin

User name Used only with SFTP server

User authorization can be done with either
password or key file

export_location.p
assword

Password Used only with SFTP server

Password for the user

export_location.p
ublic_key_file

Public Key file Used only with SFTP server

Fully qualified path to public key file, please use
forward slashes

export_location.p
rivate_key_file

Private Key file Used only with SFTP server

Fully qualified path to private key file, please use
forward slashes

export_location.p
roxy_name

Proxy server to use Used only with SFTP server

name or IP address

export_location.p
roxy_port

Port number of the proxy
server

Default: 8080

Used only with SFTP server

Port to connect to proxy server

 

This setting is language independent. The dialog only appears if specifications are made.

[export_location.1] - Configurations for the first export location
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Parameter Supported Values
Default Value

Description

export_location.o
utput_dir

Specify a directory

Default: C:/

Setting for the first export directory. Please use
forward slashes to separate the directories.

 

[export_location.2] - Configurations for the second export location

Parameter Supported Values
Default Value

Description

export_location.o
utput_dir

Specify a directory e.g. //
server/output

Default: no default setting

Setting for the second export directory. Please
use forward slashes to separate the directories.

 

[ImageCapture]

[ImageCapture] - Section of the SignDoc2.ini configuration file to configure image capture
from scanners, webcams etc

Parameter Supported Values
Default Value

Description

device_filter_expr <regular expression>

Default: TWAIN.+Cam|
iphone

This setting specifies a filter for image capture
devices. Devices get their driver type in square
brackets prepended (e.g. "[TWAIN] Integrated
Camera") and are compared with this pattern in a
case-insensitive way. Drivers that match are not
displayed.

CaptureAttach.int
erfaces

twain; wia; wia2;
direct_show

Default:
twain,wia,wia2,direct_sho
w

This setting allows to search for devices which
support the following interfaces.

CaptureSign.inter
faces

twain; wia; wia2;
direct_show

Default:
twain,wia,wia2,direct_sho
w

This setting allows to search for devices which
support the following interfaces.
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7.4 Date and Time Formatting

In the SignDoc2.ini configuration file these expressions may be used for the date formatting:

Expression Output

d The day as number without a leading zero (1 to 31)

dd The day as number with a leading zero (01 to 31)

M The month as number without a leading zero (1-12)

MM The month as number with a leading zero (01-12)

yy The year as two digit number (00-99)

yyyy The year as four digit number

 

These expressions may be used for the time:

Expression Output

h The hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display)

hh The hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display)

m The minute without a leading zero (0 to 59)

mm The minute with a leading zero (00 to 59)

s The second without a leading zero (0 to 59)

ss The second with a leading zero (00 to 59)

z The milliseconds without leading zeroes (0 to 999)

zzz The milliseconds with leading zeroes (000 to 999)

AP Use AM/PM display. "AP" will be replaced by either “AM” or “PM”.

ap Use am/pm display. "ap" will be replaced by either “am” or “pm”.

 

Example format strings (assumed that Date time is 21 May 2012 14:13:09):

Format Result

dd.MM.yyyy 21.05.2012

hh:mm:ss.zzz 14:13:09.042

h:m:s ap 2:13:9 pm



Kofax SignDoc Desktop 3.4.7 - Installation and User Guide © 2016 Kofax Deutschland AG

Configuring SignDoc DesktopPage 125 of 144

7.5 Font Configuration

For creating the appearance of DigSig signatures and for filling in text fields (both in PDF
documents), extended fonts are required if characters outside the character set supported by the
standard fonts (or fonts already embedded in the document) are used.

Additional fonts may also be required rendering PDF documents.

A font configuration file is an XML document specifying the pathnames of TrueType font files and
font substitution rules. The "FontFiles" element contains the pathname of a TrueType font file. The
last component of the pathname may contain ? and * wildcards to refer to multiple files. Relative
pathnames are relative to the directory containing the font configuration file. The "Substitution"
element defines a font substitution rule, specifies the font name to be replaced and the name to be
used as replacement (both in "FontName" elements).

When a font is needed, the substitution rules whose "type" attribute is "forced" are tried in the
sequence specified in the font configuration file until a match is found. If a match is found, the font
name will be replaced by the substitute font name and the "embed" attribute of the substitution rule
will take effect. If no match is found, the original font name will be used.

Then, SignDoc Desktop tries to locate the font by trying these methods sequentially until a suitable
font (ie, one having a matching name and supporting all required characters) is found:

· match against the fonts declared in the document's interactive form dictionary (AcroForm)

· match against the names of the 14 standard fonts

· match against the fonts used by the document's pages

· match against the font files loaded by the "FontFiles" elements in the order they occur in the
font configuration file

If a suitable font is found, it will be used. Otherwise, the substitution rules whose "type" attribute is
"fallback" (or missing) are tried in the sequence specified in the font configuration file until a match
is found. The substitution rules are applied to the original font name (ie, without taking the
substitutions of type "forced" into account). If no match is found or the substitution doesn't change
the font name, SignDoc Desktop will report an error. Otherwise, the font name will be replaced by
the substitute font name and the "embed" attribute of the substitution rule will take effect. SignDoc
Desktop then tries again to locate the font by using the methods listed above.

Font substitution rules are always applied to the original, requested font name, that is, the output of
a rule is not used as input for another rule.

For embedded fonts and font files, the font name will be matched against the PostScript names
and font family names. The italic and bold attributes of the font are also compared (in case the
match is on the font family name).

Here is the Document Type Definition for font configuration files:

<?xml version="1.0" encoding="UTF-8"?>
<!-- A font configuration file specifies font files, font replacements,
     and and font substitutions. -->
<!ELEMENT SPFontConfig (FontFiles*, Substitution*)>
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<!-- Contents: either the pathname of a single font or a pathname
     containing wildcard characters * and ? in the last component
     such as c:\fonts\*.ttf. Relative pathnames are relative to the
     directory containing the font configuration file.

     The "embed" attribute controls whether the fonts will be
     embedded into the document or not.  If a font is already
     embedded and contains all required glyphs, it won't be
     embedded again. These values are available:
       no       The fonts won't be embedded
       yes      The fonts will be embedded completely
       subset   Only the required glyphs will be embedded
     The "Substitution" element can override this attribute.
     Note that documents compliant with PDF/A must embed all fonts.
     Due to implementation restrictions, embedding a Type1 font currently
     removes PDF/A compliance. -->
<!ELEMENT FontFiles (#PCDATA)>
<!ATTLIST FontFiles
    embed (no|yes|subset) "no"
>

<!-- Defines one font substitution. Font substitutions are tried one by
     one until a match is found or the end is reached.  Substitute the
     first font with the second one.  Letter case and space characters
     are ignored.  There is only one level of font substitutions, that
     is, substituted names are not subject to substitution.

     There are two types of font substitutions: If the "type"
     attribute is "forced", the substitution will be applied before
     trying to locate the font. That way, font can be substituted by
     another one even if it covers all required characters.

     If the "type" attribute is "fallback", the substitution will be
     applied only if no suitable font has been found.  The substitution
     will be applied to the original font name, ie, without taking
     a substitution of type "forced" into account.

     In other words, these steps are performed when looking for a
     font:

     - apply font substitutions of type "forced"
     - search for the font
     - If a suitable font has been found, use it
     - apply font substitutions of type "fallback" to the original font name
     - search for the font
     - If a suitable font has been found, use it

     The "embed" attribute controls whether the font will be
     embedded into the document or not.  If a font is already
     embedded and contains all required glyphs, it won't be
     embedded again. These values are available:
       default  Use the "embed" attribute of the FontFile element for the
                substituted font
       no       The font won't be embedded
       yes      The font will be embedded completely
       subset   Only the required glyphs will be embedded
     The "no", "yes", and "subset" values override the "embed" attribute
     of the FontFile element for the substituted font.
     Note that documents compliant with PDF/A must embed all fonts.
     Due to implementation restrictions, embedding a Type1 font currently
     removes PDF/A compliance. -->
<!ELEMENT Substitution (FontName,FontName)>
<!ATTLIST Substitution
    type (forced|fallback) "fallback"
    embed (default|no|yes|subset) "default"
>

<!-- Contents: the font family name or PostScript name of the font to be
     substituted or of the font used as substitute. -->
<!ELEMENT FontName (#PCDATA)>
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Example

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE SPFontConfig SYSTEM "SPFontConfig.dtd">
<SPFontConfig>
  <FontFiles embed="yes">c:\fonts\LinLibertine_*.ttf</FontFiles>
  <FontFiles embed="yes">c:\fonts\DejaVu*.ttf</FontFiles>
  <Substitution type="forced">
    <FontName>Times Roman</FontName>
    <FontName>Linux Libertine</FontName>
  </Substitution>
  <Substitution>
    <FontName>Helv</FontName>
    <FontName>DejaVu Sans</FontName>
  </Substitution>
  <Substitution>
    <FontName>Helvetica</FontName>
    <FontName>DejaVu Sans</FontName>
  </Substitution>
  <Substitution>
    <FontName>Arial</FontName>
    <FontName>DejaVu Sans</FontName>
  </Substitution>
</SPFontConfig>

 

The fonts referenced by these font configuration files can be obtained from http://dejavu-fonts.org
and http://linuxlibertine.sourceforge.net.

8 SignDoc Desktop ActiveX Component

Installing Signdoc Desktop ActiveX Component

Sample for SignDoc Desktop ActiveX Component

8.1 Installing Signdoc Desktop ActiveX Component

 IMPORTANT NOTE

If you used the setup provided by Kofax to install SignDoc Desktop, then it is not necessary to
register the ActiveX Component manually.

If you would like to use the SignDoc Desktop ActiveX Component it is necessary to perform some
additional installation steps as described below:

· Start the command line window by entering the command run in the Start menu, then type
cmd and go to the SignDoc Desktop installation folder. Default location:

C:\Program Files\Kofax\SignDocDesktop

· Register the ActiveX Component sdvax32.dll:

To register, please enter following command into the command line window:

regsvr32 sdvax32.dll

and press the Enter key.

http://dejavu-fonts.org
http://linuxlibertine.sourceforge.net
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· A message notifying about the registration result as shown below will appear:

· Click the OK button.

 

Sample for SignDoc Desktop ActiveX can be found in:

C:\Program Files\Kofax\SignDocDesktop\ActiveXSample\Sample.zip

 

See the chapter Sample for SignDoc Desktop ActiveX.

8.2 Sample for SignDoc Desktop ActiveX Component

Delivered with SignDoc Desktop a C# sample shows how to integrate the SignDoc Desktop
ActiveX Control. The sample can be found in Sample.zip file that is located in the SignDoc
Desktop installation folder. The default setting for the installation folder is:

C:\Program Files\Kofax\SignDocDesktop\ActiveXSample

To start using the sample, please perform following steps:

1. Unpack Sample.zip file.

2. Make sure that SignDoc Desktop ActiveX Component sdvax32.dll is registered. See the
chapter Installing SignDoc Desktop ActiveX Component.

3. Please set the environmental variable PATH to include the folder where following 3 files are
located. These files can be found in:

Sample.zip\ActiveX\CS.Sample.Ax\bin\Release

§ AxInterop.sdvax32Lib.dll
§ Interop.sdvax32Lib.dll
§ CsSampleAx.exe

4. To start the sample run CsSampleAx.exe
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Below picture shows the C# sample with loaded PDF document:
 

 

The sample shows how to implement the following ActiveX interfaces:

· load a document to the ActiveX Control

· save a document loaded in the ActiveX Control

· save a document loaded in the ActiveX Control to a new name

· close the document loaded in the ActiveX Control

 

The documentation for the SignDoc Desktop ActiveX can be found in the SignDoc Desktop
installation folder and can be started with index.html. The default setting is:

C:\Program Files\Kofax\SignDocDesktop\docu\activeX
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9 Deprecated Features

Image Capture Profiles

SignDoc FDF

9.1 Image Capture Profiles

 

· Setting up and Using Scanning Profiles

§ Adding a new Scan Profile

§ Modifying a Scan Profile

§ Removing a Scan Profile

· Image capture profiles

Setting up and Using Scanning Profiles

Scanning profiles allow you to configure re-usable settings for scanning images to be used as
document attachments. This is useful when you would like to use specific settings that are not
default to the application. e.g. specific image resolution to be used with specific scanners.

Adding a new Scan Profile

To add a new re-usable scanning profile:

· Open a document.

· Start the attachment scanner dialog by clicking the  Capture image toolbar icon at the
top toolbar.

· Click the button to open a new window  where you can enter the profile name. 
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· Enter a name for the new profile within the dialog box that pops up and click the OK button.
 

· The new scanning profile will now be available from the Profile drop-down box in the
scanning dialog. The new profile will have the default scan settings which you can modify at
a later time. 

Modifying a Scan Profile

To edit or modify a scanning profile after it has been created:

· Start the attachment scanner dialog by clicking the  Capture image toolbar icon.

· Select the profile you would like to edit and click the button to edit a profile .
 

· A dialog box will open that allows you to modify parameter such as resolution, x and y scan
coordinates, Image type (B&W or color), etc. Make any modifications you desire, and click 
OK.

· Your new scanning profile is ready to use and can be selected with your next scanning
operation.

Removing a Scan Profile

To remove a scanning profile that you no longer need:

· Start the attachment scanner dialog by licking the  Capture image toolbar icon.
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· Select the profile you would like to edit and click the button to remove a profile .
 

· You will be prompted to confirm the removal of the profile with OK.

Image Capture Profiles

Image Capture Profiles provide a convenient way to predefine profiles for scanning images or
capturing images with a webcam.

It makes it possible to use different fixed image capture settings for different scenarios, for
example:

· a passport could only be scanned in gray scale with 150dpi and a size of 150mm x 100mm

· a document scan could only use black&white but with 200dpi resolution
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Add a new profile by assigning it a new name:
 

 

Edit the properties of the profile.

In this example, the profile Passport Scan has predefined parameters:

· uses grayscale

· scan resolution is 150dpi

· the scan rectangle is from 0mm,0mm to 150mm,100mm
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9.2 SignDoc FDF

Merging FDF Documents with PDF Documents

You can merge FDF (Forms Data Format) documents with PDF documents by using the command
line utility SignDocFDF.exe.

After the documents were merged, the resulting PDF will be opened automatically in SignDoc
Desktop.

 

Usage

SignDocFDF FDF_FILE [PDF_FILE] OUTPUT_PDF_FILE

 

Parameter Description

FDF_FILE FDF (Forms Data Format) file

PDF_FILE PDF input file (template). If the input file is specified by in FDF file, this
parameter is optional.
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Parameter Description

OUTPUT_PDF_FILE Filename of merged output document.

 

Example

SignDocFDF.exe c:\temp\fdf\CarLeaseb.fdf c:\temp\fdf
\CarLeaseb_only_input.pdf c:\temp\fdf\CarLeaseb_out.pdf

 

10 Limitations and Known Issues

Limitations

Known Issues

10.1 Limitations

In this section you will find a list of some limitations in the function of SignDoc Desktop:

· Deleting digital signature fields in TIFF documents is not supported.

· Unable to edit some interactive fields such as radio buttons.

· During signature capture, the rotation of the display must not be changed on some Tablet
PCs.

· Background images may not be deleted on some StepOver LCD tablets after signature
capture.

· Only webcams and scanners that support the TWAIN, WIA or DirectShow interface can be
used with SignDoc. If the image capture dialog is unable to take a snapshot or in general is
not functioning properly, please uninstall all drivers for other image capture devcies and
ensure only the correct manufacter driver is installed.

10.2 Known Issues

This section provides information on known issues:

· DCT-encoded (lossy JPEG) images are ignored in document integrity checks.

· Adobe digital signatures in "complex" documents are not supported in document integrity
checks.

· Image capture using the Microsoft Surface Pro rear webcam is not supported.

· SOFTPRO Printer Driver. If special characters are included in the file name of a Word
document, these characters are lost after printing with the "SOFTPRO PDF TIFF Converter"
or will not be properly implemented.

· SOFTPRO Printer Driver instabilities on Windows 8. The SOFTPRO Printer Driver is not fully
supported in Windows 8. There are known issues during installation and usage.

· TIFF document does not support pen color settings.
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11 SignDoc Desktop License

Demo License

Request Time Unlimited License

Obtaining the Installation Code

Installing SignDoc Desktop License

Where to purchase SignDoc Desktop license?

11.1 Demo License

SignDoc Desktop is delivered with a time limited demo license. The demo license allows using all
features of SignDoc Desktop within demo license validity time.

 

 NOTE

The demo license is valid for 90 days. After your demo license expires it is necessary to
purchase the valid license in order to continue to use SignDoc Desktop.

 

To check the license validity please start the SignDoc Desktop application and select: 

Help > License Information

The License Viewer dialog will be opened and the following fields will indicate the license expiry
date:

· The field Expiry date shows the date when the demo license will expire.
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· The field Remaining offline days shows in how many days the license will expire.

 

 

11.2 Request Time Unlimited License

To request the full license please send the license request e-mail to splm@softpro.de with
following information:

· Purchase order number

· Complete contact data

· Name of the product for which you would like to request the license (for example SignDoc
Desktop)

· Installation code of the machine, where the product is installed (please see below how to
obtain the installation code)

Once SOFTPRO license management team receives the inquiry, it will be processed and you will
be sent a corresponding license file SignDoc.lic by e-mail. Please see below the procedure
describing installation steps for the SignDoc Desktop license.

11.3 Obtaining the Installation Code

To obtain the installation code, please perform following steps:

1. Start License Viewer dialog, by selecting:

Start > Programs > Kofax > SignDoc Desktop > License Viewer

mailto:splm@softpro.de
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2. Click the button Copy installation code.

3. The installation code will be copied into the clipboard.

4. The copied installation code can now be pasted directly into the e-mail body.

 

 

11.4 Installing SignDoc Desktop License

Please perform the following steps to install the new license file for SignDoc Desktop:

1. Kofax will send the new license file SignDoc.lic to you by e-mail.

2. Please save this license file onto the computer in a preferred directory.

3. Start SignDoc Desktop application and select:

Help > License Information

4. Click the button Install License.

5. A file selection dialog will be opened, please browse to the folder, where the received
license file has been saved.

6. Select the license file SignDoc.lic and click the button Open.

7. Click the OK button.

8. Restart SignDoc Desktop application.
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11.5 Where to purchase SignDoc Desktop license?

For license requests, please contact Kofax sales team.

12 Appendix

Contact Information

Trademarks

Copyright Notice

 

12.1 Contact Information

Our support team will be happy to assist you.

 

Kofax Customer Portal

If you need support with regards to purchased Signature products please contact us via

https://techsupport.kofax.com

We recommend to use Internet Explorer in case you experience problems with other browser
software.

 

Address

You can also send your inquiry to the following address:

Kofax Deutschland AG
Wilhelmstrasse 34
71034 Boeblingen

Germany

 

12.2 Trademarks

· SIGNPLUS, SignDoc, SignWare, SignInfo, SignCheck, SIVAL, SignPad, SignSecure are
registered trademarks of Kofax Inc. or its affiliates – all rights reserved.

· Bonjour and the Bonjour logo are trademarks of Apple Inc.

· All other brand and product names can be trademarks, service marks or other intellectual
property of the respective owners who reserve all related rights.

http://www.kofax.com/products/kofax-signature-solutions
https://techsupport.kofax.com
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12.3 Copyright Notice

© 2016 Kofax Deutschland AG

This documentation, including all of its parts, is copyright protected. All rights reserved; every use
not explicitly permitted by copyright law or by a license agreement requires prior consent.

This and similar notices may not be removed or altered.
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